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What's New in motif.factory 3.10.02 (23/12/2023)
Provided a workaround for the OSX Java file selector bug that reports a non existent directory when
you have double clicked a directory to select it.

• 

Improved registration process. You now no longer have to quit the program to activate the disabled
features once registered and activated.

• 

Application rebuild to stay current with latest version of Java 17, required libraries and build tools.• 

Previous Versions
V3.10.01 (20/12/2022)

Fixed a bug in drag and drop (most noticeable in kronos.factory and montage.factory due to file sizes)
where drag and drop operations were occasionally failing and providing an error message about copy
and paste not being possible.

• 

Fixed a bug where using the View/Refresh menu option killed drag and drop.• 
Updated the status bar's file name display to show a truncated path (with the filename fully visible) if
the the full path will not fit in the available space.

• 

V3.10.00 (08/05/2022)

Updated how the applications are built. The Java Runtime is now embedded and updated to Java 17
as the minimum version. There is no longer a need for a standalone version of Java to be installed

• 

New installers for OS X (DMG), PC (MSI) and Linux (DEB) and basic ZIP and TAR packages.• 
The OS X DMG package is notarized for compatibility with the OS X security model.• 

V3.9.02 (05/07/2020)

Fixed problem on OS X Mojave and Catalina which was preventing access to protected folders.• 

V3.9.01 (28/04/2020)

Fixed a bug with the default library path that was creating a new library under the main library.• 
Introduced the Preferences option to allow the library path to be set.• 

V3.9.00 (18/04/2020)

If you double click on a voice, it will be sent to the synth's edit buffer. If you use a triple click action
instead, the MIDI router is automatically opened after the voice is exported.

• 

The application now supports MIDI data logging to the application log, which can be enabled in the
Preferences/Misc Tab. It is recommended that this is not normally turned on, and it is only needed
when required to help me diagnose any MIDI issues that are reported if you are experiencing any
such issues.

• 

The Minimum Java Version is now Java 11, and I have rebuilt the applications with the latest support
libraries. The migration to Java 11 is a significant step, as I have been help back from migrating to
Java 9 and above due to Java PC MIDI issues that were causing garbled MIDI port names, which
made it impossible to select MIDI ports. These issues are now resolved in the recommended JREs.
Please see the Java Support page on the website for more details.

• 

The applications support iMac Retina displays.• 

V3.8.05 (22/12/2018)

No functional changes. The Application is now built using new build tools and libraries, as some of the
ones I was using were obsolete and no longer supported. I am changing these as part of longer time
migration plans to Java 9 and above.

• 

The Minimum Java Version is now Java 8, as Java 7 as Oracle no longer provide public updates to
Java 7.

• 

V3.8.04 (22/10/2017)

OSX Users - Updates to how devices are named in CoreMIDI4J to provide better device identification,
which means that you may need to reselect your devices in MIDI Preferences as they may now be
named differently.

• 

OSX Users - I've finally figured out how to get rid of the confusing default drag image that OS X adds
on top of the drag images that I am generating.

• 

Small GUI update to change background colour of object selections (the default colours since Java 7
are not good).

• 

V3.8.03 (13/08/2017)

Further improvements to error logging.• 
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V3.8.02 (08/07/2017)

General improvements in MIDI report handling to report identified port issues to the user.• 
When importing many items and MIDI timeouts are being experienced, then you now have the option
to abort or continue the transfer

• 

Fixed bug in the database that prevented the author being correctly displayed when it was being
edited, and added context menu options to allow multiple objects to have the Author value edited at
the same time.

• 

Added application error logging to make debugging easier.• 

V3.8.01 (24/12/2016)

Improved database access performance when editing information.• 

V3.8.00 (25/07/2016)

CoreMidi4J is now embedded in the application for OS X Users. So there is no longer a need to
download and install a MIDI Service Provider extension for OS X.

• 

V3.7.00 (28/03/2016)

Updated all x.factory Librarians to use CoreMID4J on Mac OSX.• 
Updated all x.factory Librarians to use Launch4J application launcher on PC.• 
The minimum JRE version is now Java 7.• 

V3.6.00 (28/06/2014)

Updated all x.factory Librarians to use a new automated licensing system.• 

V3.5.00 (27/08/2012)

Updated MIDI Router to allow the MIDI Channel to be either the channel sent by the source device, or
to be the channel specified in the MIDI Options Dialog.

• 

V3.4.00 (23/08/2012)

Updated application to work with MMJ on OS X to provide access to external MIDI devices. The move
to MMJ is required because the Mandolane MIDI SPI is no longer supported and doesn't work on OS
X Lion and above.

• 

The MIDI Router is now available on the MIDI Menu.• 

V3.3.03 (19/01/2012)

Updated Java Launcher to work on OSX Snow Leopard and OSX Lion.• 

V3.3.02 (07/11/2011)

Updated Windows Installer to detect 32 or 64 Java Runtime Environments (JREs) and to configure
the application launcher to make use of a 64 bit JRE if available.

• 

Fixed bug that was preventing the selection of Table Views if the application was not registered• 

V3.3.01 (29/10/2011)

Fixed bug in the File/Save As... function, which was causing a null pointer exception when saving a
new file.

• 

V3.3 (11/08/2011)

Added a new feature to recreate files from the library (note this will only work with Libraries created in
V3.3. onwards)

• 

Added File and Author views to the Database.• 
Added an context menu option to the Database views to allow you to see what files are using an
object.

• 

File/Save As now allows you to change the file type when saving the file.• 

V3.2 (14/05/2011)

Library Statistics dialog added, allowing you to see how big the Library is!• 
Batch importer for importing Motif files into the Library• 
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V3.0.02 (01/07/2010)

When a Mixing Template from an ES keyboard file is copied to a Multi in an ES Rack keyboard file,
the name of the parent Song or Pattern is used to name the Multi

• 

Added support for converted Mixing Voices to User Voices when copying a Mixing Template from an
ES keyboard file to a Multi in an ES Rack keyboard file

• 

When a Mixing Template from an ES keyboard file is copied to a Multi in an ES Rack keyboard file,
any parts that were using custom Waves are reset to point a Preset Voice.

• 

V3.0.01 (16/12/2009)

Corrected problem where file data paths on non-English locales were not being found.• 
Updated license code to allow sy.factory to unpack a license.zip if it is found in the license folder,
which simplifies installation particularly for Mac OSX users, where the standard zip extractors were
causing problems with the license file. sy.factory can also now detect a license.lic file if this has been
inadvertantly extracted

• 

V3.0 (23/11/2009)

Library support has been added, which allows you to keep all of your favourite items (e.g. Voices,
Performances, etc.) in one Library database, and then sort and filter them to find the patch that you
want. This feature is only available for registered users.

• 

V2.0.01 (04/11/2007)

The List Object References function now shows if User Voices are referenced by Song Tracks,
Pattern Tracks and Mixing Template Tracks.

• 

V2.0 (07/10/07)

Full support added for the Motif ES 6/7/8 keyboards and their file formats, including:
W7A All files♦ 
W7E Voice Editor Files♦ 
W7G Arpeggio Files♦ 
W7P Pattern Files♦ 
W7S Song files♦ 
W7V Voice Files♦ 
W7W Wave Files♦ 

• 

This ES keyboard support includes full support for copying ES data, including copying referenced
objects. For example if you copy a Master referring to a performance to a new file, then the
performance is copied along with any referenced user data in the performance (e.g. Arpeggio, User
Voices, User Waves, etc.).

• 

Support for reading S90 ES Voice Editor (S7E) Files. A Motif ES voice editor file is created.• 

V1.0 (16/12/2006)

First release of motif.factory, supporting the Motif Rack ES• 
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Installation and Configuration of motif.factory
motif.factory is downloaded as a self installing file, so installation is automatic, and for most users little else, if
anything, needs to be done to get up and running.

A native installer for Windows is also available.

This section is only relevant to installing additional items not included as part of the motif.factory installer.

Installing MIDI Extensions for MacOS X
If you wish to use the MIDI support provided on Mac OSX, then a Java MIDI Service Provider extension is
required.

The extensions provide MacOS X Java programs access to all CoreMIDI devices

An extension is required because, historically, the Java implementation on OS X is not able to access external
MIDI devices. Apple/Oracle claim to have fixed the external MIDI device access problem in its Java
implementation. However, it appears that only "simple" MIDI messages are now supported. SYSEX data
transfer (essential for transferring synth data) is not supported.

motif.factory now embeds CoreMIDI4J in the application package, so you no longer need to download and
install it separately. However, if you still require an SPI for other Java MIDI software then you will need to
ensure that you have the latest compatible version of CoreMIDI4J, as if an SPI is installed in the
/Library/Java/Extensions folder then this will override the version of CoreMIDI4J embedded in motif.factory.

If you are not using any other Java software that requires MIDI access, it is best to remove any existing
version of CoreMIDI4J from the /Library/Java/Extensions folder so that motif.factory can access the
CoreMIDI4J version embedded in the package. That way you can ensure that motif.factory is always using the
latest compatible version of CoreMIDI4J.

motif.factory will warn you if it detects an earlier version of CoreMIDI4J. It will still function, but will not benefit
from recent CoreMIDI4J bug fixes or enhancements.

If you need to retain a version of CoreMIDI4J in the /Library/Java/Extensions folder then you can always
download the latest version of CoreMIDI4J.jar from  CoreMIDI4J Releases

Once you have downloaded CoreMIDI4J.jar it needs to be copied to the /Library/Java/Extensions folder. You
will need to provide administrator permissions to copy the files.

Once installed, when running the librarians and selecting the MIDI ports to use, select the ports prefixed with
CoreMIDI4J -. For example my Edirol UA-25 interface that I use for testing on OS X is listed as CoreMIDI4J -
UA-25. The latest version of motif.factory will only list CoreMIDI4J devices.
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Registering motif.factory
You need to register motif.factory to allow MIDI data to be exported to the Motif, for data to be saved to your
computer and for Library Support to be enabled.

Please refer to the x.factory Librarian Registration Page for details on how to register motif.factory.
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Running motif.factory
Starting up motif.factory is as simple as starting any application, simple double click on the icon and you're
away.

If you have registered motif.factory, then the Library will be created (if it doesn't already exist) and opened.

During start-up, a "Splash Screen" is shown. This stays visible until a few seconds after the program has
loaded and is ready for use, but can be dismissed at any time by clicking on the Splash Screen.

motif.factory remembers the size and position of the main window between sessions, so the main window will
be sized and positioned as you left it the last time.

PC
Simply double click on the program icon for the program either in an Explorer shell, or from the desktop if you
let the installer placed a shortcut there.

You can also select the program from the Start Menu. By default, motif.factory can be found under the
x.factory Librarians Program Group.

IMPORTANT NOTE: If the application is failing to launch on a PC with a 32 bit version of Windows, then
please read the Section on adjusting the JRE Memory Configuration, as the failure is more than likely to be
due to an out of memory condition.

MAC OS X
Navigate to the Applications folder in Finder and double click the motif.factory application.

You can also create "Aliases" of the application and place them anywhere you wish, such as on the desktop

To make an alias you can choose any one of the following methods:

Click the motif.factory item you have just identified and hold down the mouse button. Then, while
holding down the Command and Option keys simultaneously, drag the item to where you want the
alias to appear then let go of the mouse button and finally release the two keys. This will create an
alias at your desired location. While dragging, the ‘ghosted’ item will display a shortcut arrow which will
remain on the aliased icon when it has been created.

• 

Hold down the Ctrl key, and then click the motif.factory item as identified previously. The context
menu will be displayed, and one of the choices will be Make Alias. Click that option, and then release
the key. The motif.factory alias will appear next to the original item and can be dragged to your
location of choice.

• 

Select the motif.factory item you identified previously by clicking it once then press Command-l
(lowercase L). The motif.factory alias will appear next to the original item and can be dragged to your
location of choice.

• 

Click the motif.factory item once to select it, and then from the File menu, select Make Alias. The
motif.factory alias will appear next to the original item and can be dragged to your location of choice.

• 

Note that if your alias does not have a small arrow in the lower left corner then you have not correctly created
an alias and have probably just dragged the application launcher to a new location. If so, drag it back to the
Application folder and start again.

Command Line
You can also startup motif.factory from a command shell (e.g. MsDOS). Simply change directory to where
motif.factory is located and type the following:

java -jar motiffactory.jar
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The motif.factory Window
The main motif.factory window looks like this

The motif.factory user interface is a Multiple Document Interface (MDI), which allows you to have more than
one file open at a time.

The interface is divided into the now familiar layout of (from top to bottom):

The Title Bar• 
The Menu Bar• 
The Tool Bar• 
The Desktop• 
The Status Bar• 
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Menu Bar
The motif.factory menu bar provides a means of selecting common operations; typically those that affect a
complete file, or those that don't fit naturally upon a context sensitive popup menu.

Keyboard Shortcuts are provided for common operations.

motif.factory also provides context sensitive popup menus, which are accessible by right clicking over data
shown in a Child Window. Naturally the contents of the popup menus varies according to the type of data over
which the menu was popped up.

Main Menu Headings

The following menu headings are available.

File Menu• 
Edit Menu• 
View Menu• 
MIDI Menu• 
Tools Menu• 
Window Menu• 
Help Menu• 
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The File Menu

The File menu provides the following options:

New ...

Shows the Create New File Dialog, which allows you to create a new file.

Open ...

Shows the Open File Dialog, which allows you to open a specified file.

Save

Saves a file using its current name.

If the file in question is a newly created file, then the Save File Dialog is brought up to allow a name to be
entered.

Save As ...

Saves the selected file after a name has been entered in the Save File Dialog.

Save All

Saves all files that have been modified using their current names.

Open Workspace ...

This option allows you to select a previously saved Workspace, which is a Collection of open windows, and
their size and position within the main motif.factory window.

When you select this option, a dialog opens which allows you to select an motif.factory workspace file (EXW).

Save Workspace ...

This option allows you to save the current size and position of the main motif.factory window, and the
arrangement of the open windows within motif.factory to a Workspace file.

Export to

This option brings up the following sub menu:

These options allow you to Export the data in the currently selected file to a variety of different formats.
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Exit

Exits the motif.factory application.

If any files have been modified and have not been saved, you will be given the option of saving them.

Recently Opened Files

The file menu also contains a list of recently opened files to allow easy access to files that you are currently
working upon. The recently open files list appears at the bottom of the file menu.
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The Edit Menu

The  Edit menu provides the following options:

Undo

Undos the previous edit stored in the Undo Buffer.

Redo

Redos the next edit stored in the Undo Buffer.

Clear Undo Buffer

Clears the Undo Buffer.

Cut

Places a copy of the selected Object(s) onto the Clipboard and deletes the selected Object(s) from the file.

Copy

Places a copy of the selected Object(s) onto the Clipboard.

Paste

Copys the Object(s) on the Clipboard into the highlighted location within the current file.

Find ...

motif.factory supports the ability to find Objects either by name or by category (where an Object supports
categories, such as Voices).

Searches start from the currently selected Object.

Selecting the Find ... option brings up the Find dialog, that allows you to specify the string to search for, along
with options that can be used to refine the search.

Find Next

If you have defined the Find criteria within the Find dialog, then this option will repeat the search using the
same criteria.

Find Category ...

You can also search by category be selecting Find Category ... option, which brings up the Find Category
Dialog.

Find Next Category

If you have defined the Find Category criteria within the Find Category dialog, then this option will repeat the
search using the same criteria. 

Goto ...

Selecting this option brings up the Goto Dialog, which allows you to quickly navigate to a numbered Object.
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The View Menu

The  View menu provides the following options:

Note how some of the options change depending on whether or not the Child Window is split.

When the Child Window is split the Left/Top Pane and Right/Bottom Pane menu options have the following
sub menu.

Tool Bar

When checked the motif.factory Tool Bar is visible.

Status Bar

When checked the motif.factory Status Bar is visible.

No Split

When checked the current Child Window is not split.

Horizontal Split

When checked the current Child Window is split horizontally.

Vertical Split

When checked the current Child Window is split vertically.

Tree

When checked the main/left/top pane in a Child Window displays data in a Tree View.

Table

When checked the main/right/bottom pane in a  Child Window displays data in a Table View.

Refresh

Refreshs all open Child Windows.

This command is provided in case the screen is not properly updated following an edit operation. There are a
couple of odd bugs I cannot track down on screen updates. So if you come across them as well, then this
command will force a redraw of the windows.

Preferences ...

Opens the motif.factory Preferences Dialog.
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The MIDI Menu

The MIDI menu provides the following options:

Import From MIDI

Imports Voices and Performances from the Motif via MIDI to the currently selected Window.

Export to MIDI

Exports Voices and Performances to the Motif via MIDI from the currently selected Window.

Note: The Export To MIDI option is only enabled if you have registered motif.factory.

MIDI Router ...

Opens the MIDI Router Dialog which allows you to use another keyboard to audition Motif Data.

MIDI Preferences ...

Opens the Preferences Dialog with the MIDI Preferences Tab active.
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The Tools Menu

The  Tools menu provides the following options:

Master Patch List ...

Opens the Master Patch List dialog.

Library Information ...

Opens the Library Statistics dialog.

This option is only enabled if your copy of motif.factory is registered.

Batch Import to Library ...

Opens the Batch Import To Library dialog.

This option is only enabled if your copy of motif.factory is registered.
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The Window Menu

The  Window menu provides the following options:

In the example given above, you'll see that after the predefined menu options there are menu options that
allow you to select the windows currently open within motif.factory (ORGANVCE.W7E and ORGNES.W7E in
our example menu).

Tile Horizontal

Arranges all non-minimised Child Windows along the horizontal axis.

Tile Vertical

Arranges all non-minimised Child Windows along the vertical axis.

Maximise Windows

Maximises all Child Windows so that they all occupy the size defined by the desktop.

Restore Windows

Restores all maximised/minimised Child Windows to their normal state.

Minimise Windows

Reduces all Child Windows to their iconised state.

View Motif Synthesizer Data

Opens or closes the Motif Synthesizer Window which provides a view on preset and user Motif synth data.

View Motif Library

Note: This menu option is only visible if you have registered motif.factory.

Opens or closes the Motif Library Window which provides a view on the Motif Library.
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The Help Menu

The Help menu provides the following options (OS X and Windows versions are shown):

Search

OS X only. This is a standard OS X Menu function currently not working with motif.factory. One day....

Get Help on motif.factory ...

Displays the motif.factory Online Help system.

View Tips and Tricks for motif.factory ...

Displays the motif.factory Tips and Tricks Dialog.

View PDF Documentation for motif.factory ...

Displays the PDF documentation for motif.factory. Note that there needs to be a registered viewer for PDF
files on your system for this command to work

View License Agreement for motif.factory ...

Displays the motif.factory License Agreement in a dialog box.

View License Agreement for motif.factory ...

Provides a link to the x.Librarian's Support Page.

About motif.factory ...

This menu option is not available if the host operating system is OS X. On OSX there is an About
motif.factory menu option in the  motif.factory Application Menu.

Displays the motif.factory About Dialog, which provides some basic information about the program, such as
the version number.

Register and Activate motif.factory ...

Displays the motif.factory registration and activation Dialog.

See the Registration Section for details of how to register motif.factory.
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Tool Bar
The Tool Bar contains buttons for common operations, such as opening and saving files.
   Creates a new file
   Displays the Open File Dialog to allow you to select a file to open
Saves the currently selected file

   Displays the Save As Dialog to allow you to select a different name for the currently selected file
Saves all the open files to disk

   Cuts the selected Objects and places them on the Clipboard
   Copies the selected Objects and places them on the Clipboard
   Pastes the contents of the Clipboard to the current selection
Undos the previous edit
Redos the previous edit

   Displays the Find Dialog to allow you to define the search criteria and then search for the first occurence
   Searches for the next occurence of the search criteria defined in the Find Dialog
   Imports Voices/Performances from the Motif via the MIDI interface
   Exports Voices/Performances to the Motif via the MIDI interface
   Displays the Preferences dialog where you can configure motif.factory
   Displays the motif.factory Online Help index page
   Enables Context Sensitive Help
   Displays the Tips and Tricks Dialog
   Displays the About Dialog

The Save and Midi export buttons are only enabled if motif.factory is Registered.

The Tool Bar can be dragged and made a floating toolbar by clicking and dragging the handle to the left of the
Tool Bar.

The Tool Bar can also be dragged to a different window border other than the top border.

The Tool Bar can be hidden/unhidden by the Tool Bar menu option on the View menu.

The Tool Bar whilst floating can be docked once more by closing it.
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Desktop
The Desktop portion of the window is where the Motif data is portrayed. Several files may be opened and
shown within Child Windows upon the Desktop portion of the window. The following example shows
three Child Windows open on the Desktop.

The Window Menu provides menu options to:

Tile (either vertically or horizontally) all Child Windows that are not iconised• 
Minimise all Child Windows• 
Maximise all Child Windows• 
Restore all Child Windows• 
Select a specific Child Window• 
Open the Motif Synthesizer Window• 
Open the Motif Library Window• 

When a file is opened, a Child Window is added to the Desktop Area.
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Child Window
The Child Window provides the View upon the data within the file it is associated with.

The Child Window is maximised by default when it is opened, and can be minimised, restored or closed by the
buttons to the right of the Child Window's title bar.

The menu options on the View menu can be used to change the View between a Tree view and a Table view,
and a Child Window can be either split horizontally or vertically split to show any of the following
combinations:

A Tree and a Table• 
A Table and a Tree• 
Two Trees• 
Two Tables• 

The default Child Window View applied when a file is opened is set in the Default View Tab of the Preferences
Dialog.

The following example shows a Child Window that is split and showing both a Tree View and a Table View on
the same data.

The Tree and Table views support drag move and drag copy operations, and the views will automatically
scroll whilst drag operations are in progress.

motif.factory also provides two special Child Windows:

The Motif Synthesizer Window.• 
The Motif Library Window (This Window is only available if you have registered motif.factory).• 
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Tree View

The Tree View shows the Motif data as a hierarchical tree, and can show more information than the Table
View. The following example shows a split Child Window with two Tree Views, one collapsed showing the top
level Collections and one showing a Voice (U2-014) that has been expanded to show more information
on the Voice.

Basically, information is shown as a set of hierarchical Objects. Objects may have children attached to them,
and they themselves may have further child Objects (e.g. a Voice Object, has a child Object for its Elements,
and this Object groups all the Elements of the Voice).

The basic tree structure is a Root Object at the top of the tree under which are various Object Collections
which themselves contain further data. The top level Collections that can be found under the root node varies
upon the file type:

File Type - this is the root of the data currently loaded and a container for all data held in the Motif
Synthesizer data file which has been loaded. This root is always present and indicates the type of file
loaded

• 

User Voices• 
User Drum Voices• 
User Plugin Voices• 
User Performances• 
User Multis (ES Rack) or User Mixing Templetes (ES Keyboard)• 
User Masters• 
User Arpeggios• 
User Patterns• 
User Songs• 
User Song Chains• 
User Mixing Templates• 
User Waves• 
System Configuration Data• 

You can double click on an item, and if the item is a voice, it will be exported to the synth's Edit buffer

You can also triple click on an item, and if the item is a voice, it will be exported to the synth's Edit buffer and
the MIDI Router will also be opened

Objects are displayed in one of three colours:

Black if the Object is not referenced by another Object• 
Blue if an Object is referenced by another Object (e.g. a Voice being used within a Performance)• 
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Red if an object is considered to be empty. Empty objects are not saved in data files (e.g. empty
Waves)

• 

The Tree View allows multiple Objects to be selected, which is useful for performing operations only upon
certain Objects. You can only perform operations upon Objects of the same type.

If you wish to perform an operation upon all Objects in a Collection, simply select the Collection containing the
Objects.

If you right click over an object or selection of objects within the Tree View, a context sensitive popup menu
will appear that provides the editing operations that can be performed upon the object(s).

Objects can be Copied and Moved either within or between Child Window Views using Drag and Drop.
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Table View

The Table View provides a more high level overview of the data than the Tree View, and the representation of
the data is more compact. The following example shows a Child Window with a single Table View providing
information on a file's Voices.

The Table View can only show one Collection of Objects at a time.

You can select what a Table View shows by right clicking within the table to access the context sensitive
menu, upon which can be found menu options to select the different data types available in a file.

Each row within the table shows one Object.

You can double click on a row, and if the item is a voice, it will be exported to the synth's Edit buffer

You can also triple click on an row, and if the item is a voice, it will be exported to the synth's Edit buffer and
the MIDI Router will also be opened

If you right click over an object or selection of objects within the Table View, a context sensitive popup menu
will appear that provides the editing operations that can be performed upon the object(s). The cells in a Row
that contain the Object's Category, Sub Category and Object Name (if available) can be directly edited by
clicking in them.

Objects are displayed in one of three colours:

Black if the Object is not referenced by another Object• 
Blue if an Object is referenced by another Object (e.g. a Voice being used within a Performance)• 
Red if an object is considered to be empty. Empty objects are not saved in data files (e.g. empty
Waves)

• 

Objects can be Copied and Moved either within or between Child Window Views using Drag and Drop.
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Motif Synthesizer Window

The Motif Synthesizer Data Window is made visible by ensuring the View Motif Synthesizer Data option in
the Window Menu is checked.

This Child Window is a special View that shows the following Motif Preset and User Data  Collections:

Preset Synth Data• 
User Synth Data• 

Preset Synth Data

This Collection contains Collections for the Motif preset data, including:

Preset Voices (Banks P1 to P6)• 
Preset GM Voices• 
Preset Drum Voices• 
Preset GM Drum Voices• 
Preset Waves• 
Preset Arpeggios• 
Preset Audition Phrases• 

This data can be used to set Objects within the Motif data files to point to preset data. For example if you drag
a Preset Wave onto an AWM Element within a file, then the Element will be updated to reference the Preset
Wave.

motif.factory supports the following drag operations upon preset data:

Preset Voices, Drum Voices, GM Voices and GM Drum Voices can be dragged onto Performance
and Multi Parts

• 

Preset Waves can be dragged onto AWM Elements• 
Preset Arpeggios can be dragged onto Voice, Performance and Multi Arpeggiator Units• 
Preset Audition Phrases can be dragged onto Voice Audition Units• 

Note: only drag copy operations are supported where preset data is a drag source, as it does not make sense
to try and move preset data.

User Synth Data

This Collection contains Collections for user data within the Motif, including:

User Voices• 
User Drum Voices• 
User Plugin Voices• 
User Performances• 
User Multis• 
User Masters• 
System Configuration• 

The purpose of showing these User Data Collections is to allow drag and drop transfers of data between
motif.factory and the Motif via the MIDI Interface
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Motif Library Window

Note: This Window can only be opened if you have registered motif.factory.

The Motif Library Data Window is made visible by ensuring that the View Motif Library option in the Window
Menu is checked.

This Child Window is a special View that shows the contents of the Motif Library.

Like the standard Table View, you can select the view of type of objects that you wish to view (e.g. Voices,
Performances, etc.), which includes Files and Authors that are stored in the Database.

The window can be configured to be either a Tree or a Table view. The Table view is recommended because
filtering capabilities are available, which are described below.

Motif Library Table View Columns

The following columns can be found in the Library table.

Category The Category of an Object. Not all Objects have a defined Category
Subcategory The Subcategory of an Object. Not all Objects have a defined Subcategory
Name The Name of an Object. Note that this name can be up to 50 characters long, so you can

provide a more meaningful name for an object within the Library (the original name is
preserved for when the object is copied from the Library).

Rating Each Object object can be assigned a rating, from unrated to five stars. Filtering on this
column will allow you to quickly find you favourite items.

Comment Each object can have a comment associated with it of up to 100 characters. For example, you
could use this field to contain keywords that you use to describe a sound's character in more
detail. This could help you to define a filter to search for a sound.

Author You can define the Author for each Object. This field defaults to "Unknown" when objects are
added to the Library. You can setup motif.factory to prompt you for an Author name when a
new file is being added to the database.

Source The name of the source file that an Object was copied from when it was added to the Library.
Table Sorting

You can sort a table by a column by clicking on a column heading in the table header. for example to sort
voices by name, then click on the Name column heading. The sorting will cycle through the following states
each time you click a column header:

Unsorted• 
Sort Ascending• 
Sort Descending• 

Data Export

If you check the Automatically Export Selected Item option, then when you select a Voice it is automatically
exported to the Voice Edit Buffer.

This, for example, allows you use the cursor keys to move though the library Voices and have them
automatically exported to the Edit Buffer without having to do anything else. Please note however, that with
this option enabled, then the scrolling is slowed down. Don't forget that you can double click on a Voice to
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export it.

Table Filtering

The database table provides a very comprehensive filtering capability, which allows you to filter on any
column or combination of columns. For example, you can filter on voices with a name that contains the phrase
"Fred", combined with a category filter for "pads", combined with a type filter for AWM voices, and finally filter
for those which have a three star rating.

You can enter a filter for each column using the filter header that is above the table column names.

Table filtering works in conjunction with table sorting

A filter with a grey background is restricted to filtering by items that you can select from the drop down list. For
example, a rating value can only be unrated or rated between 1 and 5 stars

A filter with a yellow background allows you to enter a PERL Regular Expression string that acts as a filter.
Consider the following PERL examples for filtering by name:

drum will match all names containing the phrase drum (anywhere in the name);• 
^t will match all names beginning with the letter T ('^' anchors the search to the start of the name);• 
[0-9]$ will match all names ending with a number character between 0 and 9. ('$' anchors the search
to the end of the name);

• 

^M[0-9] will match all names starting with letter M followed by a numeric character.• 

That is just an overview of how you can use regular expressions for filtering. More details for how you can
form regular expression pattons can be found on the PERL Regular Expression Page

The drop down list for a Perl Regular Expression filter provides a history of the search terms entered during
the session.

Table Filter Controls

At the bottom of the table is a toolbar with the following controls:

Enable Filter Turns the filter on or off.
Configure Filter Brings up the Configure Filter dialog box allowing you to control the default behaviour of

how the Rating, Comment, Author and Source File columns are filtered.
Reset Filter Resets the filter.
Table Filter Configuration

When the Configure Filter Dialog button is selected, the following dialog appears that allows you to control
the behaviour of the filter for specific columns.

Rating - allows you to select whether or not an exact match is required, or if the filter is to allow
ratings greater than or equal to the one shown.

• 

Comment - allows you to select if a PERL Regular Expression can be entered, or if choices are
restricted to the choices provided in the drop down dialog.

• 

Author - allows you to select if a PERL Regular Expression can be entered, or if choices are restricted
to the choices provided in the drop down dialog.

• 

Source File - allows you to select if a PERL Regular Expression can be entered, or if choices are
restricted to the choices provided in the drop down dialog.

• 
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Status Bar

The Status Bar provides the following pieces of information (from left to right) for the Child Window which is
currently selected:

The name of the file currently open, if any. If no file has been selected then this field is blank. • 
The type of the file• 
Whether or not the file has been modified• 
The number of waves in use and the number that are free• 
The number of wave layers in use and the number that are free• 
The amount of wave memory in use• 
If the left/top split pane is a table this indicator identifies what the table is showing (e.g. Voices or
Multis)

• 

If the right/bottom split pane is a table this indicator identifies what the table is showing (e.g. Voices or
Multis)

• 

The Status Bar can be hidden/unhidden by the Status Bar menu option on the View menu
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Program Features
motif.factory provides the following features:

File Operarations• 
Undo/Redo Support• 
Clipboard Support• 
MIDI Support• 
Library Support• 
Find and Goto Support• 
Editing Features• 
Tools• 
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File Operations
motif.factory supports the following file operations:

Create New Files• 
Open Existing Files• 
Save Files• 
Open and Save Workspaces• 
Export Data• 
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Create New File

When the New File ... option from the File Menu or the  button on the Toolbar is selected, the following
dialog is shown:

This dialog allows you to select the type of file to create from the following:

SYSEX File• 
Motif ES All File (W7A)• 
Motif ES Voice Editor File (W7E)• 
Motif ES Arpeggio File (W7G)• 
Motif ES Pattern File (W7P)• 
Motif ES Song File (W7S)• 
Motif ES Voice File (W7V)• 
Motif ES Wave File (W7W)• 
Motif ES Rack Voice Editor File (W9E)• 

The new data file is given a name in the form of "motifFactory_n", where n is a number that increments every
time a file is created.

Note, this is different from initialising data in a file, as a totally new file is created.

Sysex files are created according to the device type set in the Device Type Preferences tab in
the Preferences Dialog.
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Open Existing File

When the Open ... option from the File menu or the  button on the Toolbar is selected, the following dialog
will appear, allowing a file to be selected.

motif.factory checks to ensure that the selected file is a valid Motif format file, and an error dialog will appear if
the file is not valid.

The following file types can be loaded:

Motif SYSEX Files• 
Motif ES All Files (W7A)• 
Motif ES Voice Editor Files (W7E)• 
Motif ES Arpeggio Files (W7G)• 
Motif ES Pattern Files (W7P)• 
Motif ES Song Files (W7S)• 
Motif ES Voice Files (W7V)• 
Motif ES Wave Files (W7W)• 
Motif ES Rack Voice Editor Files (W9E)• 
Motif S90 ES Voice Editor Files (S7E)• 

If a file selected for opening is already open, motif.factory will ask if you want to replace the file that is in
memory.

Loading Sample Files

motif.factory will also try and load a corresponding Sample (W8x) file if one is present in the same directory as
the file you are loading.

If, for example, if you load a W7A file and there is a corresponding W8A file, then the data from both files is
loaded and combined. They are split into seperate files when the data is saved. What this means is that if you
copy waves to a new file, then the sample data for the waves(if present and loaded) is also copied.

This facility can be controlled by the setting of the Sample Load Options drop down in the Misc Preferences
tab in the Preferences Dialog.

If this option is set to Confirm, then the following dialog is displayed:

If the Sample Load Options setting is set to Yes, then the samples are automatically loaded, and if the
Sample Load Options is set to No, then the samples are not loaded.

If you select No, then the samples are not loaded into motif.factory.

If motif.factory is loading a sample file and the corresponding sample file does not exist, then the following
error message is displayed:
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Importing S90 ES Voice Editor Files

If you open an S90 Voice Editor File (S7E), then a W7E file containing the S90 ES voices is created. Please
note that the S90 ES voices have some additional parameters over and above Motif ES voices, which are
ignored
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Save Open Files

When you save a file to disk using: the Save As ... command from the File Menu, or when a file created using
the New ... command from the File Menu is saved for the first time, the following dialog appears to allow you
to select a name for the file.

If a file has been created or opened and there is no associated sample file, then the following dialog is
displayed:

If you select Yes, then a companion W8x file is created.

Seperating Data in W7A and SYSEX Files

The Tree View also supports options on its Context Sensitive Menu to save data from W7A and SYSEX files
into seperate files. Note, if you select these options on files that have custom waves defined, there may be a
slight delay in between selecting the option and the filename dialog appearing as motif.factory has to create a
copy of the file in which all the redundant waves are removed.

W7A Files Collections that can be seperately saved

User Voices, User Drum Voices and User Plugin Voices can be saved to a W7E (Motif
ES Voice Editor) file by right clicking over the User Voices, User Drum Voices or User
Plugin Voices Collections and selecting the Save W7E File option

• 

User Voices, User Drum Voices and User Plugin Voices can be saved to a W7V (Motif
ES Voice) file by right clicking over the User Voices, User Drum Voices or User Plugin
Voices Collections and selecting the Save W7V File option

• 

User Voices, User Drum Voices and User Plugin Voices can be saved to a W9E (Motif
Rack ES Voice Editor) file by right clicking over the User Voices, User Drum Voices or
User Plugin Voices Collections and selecting the Save W9E File option

• 

User Arpeggios can be saved to a W7G (Motif Arpeggio) file by right clicking over the
User Arpeggio Collection and selecting the Save W7G File option

• 

User Patterns can be saved to a W7P (Motif Pattern) file by right clicking over the User
Pattern Collection and selecting the Save W7P File option

• 

User Songs can be saved to a W7S (Motif Song) file by right clicking over the User Song
Collection and selecting the Save W7S File option

• 

User Waves can be saved to a W7W (Motif Wave) file by right clicking over the User
Wave Collection and selecting the Save W7W File option

• 
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SYSEX
Files

Collections that can be seperately saved

User Voices, User Drum Voices and User Plugin Voices can be saved to a W7E (Motif
ES Voice Editor) file by right clicking over the User Voices, User Drum Voices or User
Plugin Voices Collections and selecting the Save W7E File option

• 

User Voices, User Drum Voices and User Plugin Voices can be saved to a W7V (Motif
ES Voice) file by right clicking over the User Voices, User Drum Voices or User Plugin
Voices Collections and selecting the Save W7V File option

• 

User Voices, User Drum Voices and User Plugin Voices can be saved to a W9E (Motif
Rack ES Voice Editor) file by right clicking over the User Voices, User Drum Voices or
User Plugin Voices Collections and selecting the Save W9E File option

• 
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Workspaces

motif.factory allows you to save the current size and position of the main motif.factory window, and the
arrangement of the open Child Windows within motif.factory to a file known as a Workspace.

This allows you to save a Workspace you are using for future recall at a later date.

The following parameters for each Child Window are remembered:

Window size, position and status (normal, maximised or minimised)• 
Horizontal/Vertical Splits, including split position• 
Pane type(s) (e.g. Tree, Voice Table or Performance Table)• 
Tree node expansion status• 
Table column widths• 
Scroll position of the pane(s)• 
Selection state of the tree nodes, or table rows• 
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Export Data

motif.factory allows you to export the data in the currently selected file to a variety of different formats.

HTML• 
XML• 
Cubase Patch List• 
ProTools Patch List• 
Sonar Patch List• 
SpreadSheetML• 

HTML ...

This option allows you to export a listing of the data in HTML format.

The following dialog will appear allowing you to select the features to be exported. The options presented will
depend on the type of the source file:

The saved HTML file contains as a minimum an index to the main listings (e.g. Voices/Performances) in the
file, and a section giving information on the file (such as the file type and the number of used and free
Elements).

XML ...

This option allows you to export a listing of the data in XML format.

The following dialog will appear allowing you to select the features to be exported. The options presented will
depend on the type of the source file:

This export option is intended to provide a means of importing Motif data into other programmes, e.g. a
database.

Cubase Patch Script ...
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This option allows you to export a listing of the data in Cubase patch script format. The patch script format
exported by motif.factory is compatible with both Cubase VST and Cubase SX/SL/SE.

This allows you to create patch scripts for use within Cubase to ease the selection of patches within the
Cubase environment.

See the Master Patch List dialog documentation for details on how to install patch scripts within Cubase SX.

Protools Patch Script ...

This option allows you to export a listing of the data in Protools patch script format (MIDMAN files).

This allows you to create patch scripts for use within Protools to ease the selection of patches within the
Protools environment.

Consult your sequencer documemtation for details on how to install the patch scripts within your sequencer.

Sonar Patch Script ...

This option allows you to export a listing of data in Sonar patch script format (MIDMAN files).

This allows you to create patch scripts for use within Sonar to ease the selection of patches within the Sonar
environment.

Consult your sequencer documemtation for details on how to install the patch scripts within your sequencer.

SpreadSheetML ...

This option allows you to export a listing of the data in Microsoft SpreadSheetML format.

The following dialog will appear allowing you to select the features to be exported. The options presented will
depend on the type of the source file:

This export option is intended to provide a means of importing Motif data into either Microsoft Word or Excel,
which is a great way to start documenting your patch collections.

 Program Features 36



Undo Buffer
motif.factory supports a multi-level Undo/Redo Buffer facility on all edits.

The number of edits which can be stored is 100.

The Undo/Redo commands can be found both within the Edit Menu, and on the Toolbar.

Please note that the undo buffer is global across all open files, and is cleared when any file is closed. This
may be improved in later releases.

The undo buffer can be cleared by the selecting the Clear Undo Buffer option on the Edit Menu. The
intention of this feature is to help cope with low memory situations, as it will free up the memory used by
stored edits.
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Clipboard Support
The motif.factory clipboard works just like the clipboard in other applications. It allows you to place an Object
or a copy of an Object upon the clipboard and then paste that Object elsewhere within a file or another file.

You can Cut/Copy either a single Object or a Collection of Objects onto the clipboard.

You can only paste from the clipboard to the current location in a file if it makes sense to do so. For example:

You cannot paste a Voice onto a Performance• 
You cannot paste ten Voices at the end of a Voice Collection if the selection is at Voice 374 or higher
(for the ES Rack as an example, which has 384 User Voices).

• 

The motif.factory clipboard is "local" to the application, and only motif.factory Objects can be placed upon it.

motif.factory does not support the system clipboard so it is not possible to cut and paste between motif.factory
and other applications. I don't think this is a major drawback because I cannot think of any circumstances
where you would wish to do this!
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MIDI Support
To use motif.factory MIDI export support, your copy of motif.factory needs to be registered.

Configuring MIDI Support

To configure MIDI support, go to the MIDI Preferences tab in the Preferences Dialog, and set up the following:

Input MIDI Port and Output Midi Port should be set to the MIDI port(s) to which the Motif is
connected

• 

SYSEX Device Number should match the Device Number setting in the Motif UTILITY MIDI page• 

You can check that these settings work by pressing the Test Motif MIDI Settings button. When you press this
button a test message is sent to the Motif and the subsequent Dialog will tell you if communication was
successful or if there was a problem.

The above steps set up the basic communication mechanism for MIDI support, and you then can set up the
remaining options according to your preferences:

If you wish for motif.factory to always read the Motif data on startup then check the Read Motif MIDI
Data on Startup checkbox

• 

If you wish for changes made to the Motif Synthesizer Window to be automatically written to the Motif
then check the Automatically Update Motif after Synth Window Edit checkbox

• 

You can adjust how long that motif.factory will wait for a response from the Motif by adjusting the
Timeout Delay value, which is given in milliseconds

• 

The Transmit Buffer Size, Transmit Delay Between Buffers and Transmit Delay Between Objects values
may require adjustment depending on your MIDI interface. I find that the following parameters work reliably on
my system.

Device Transmit Delay Between Buffers Transmit Delay Between Objects
USB  10ms  50ms
MIDI  50ms  100ms

motif.factory sends data to the Motif by dividing the data into packets the size of which are specified by the
Transmit Buffer Size value. When motif.factory sends a packet it waits for the time period specified by
Transmit Delay Between Buffers before sending the next packet, and it waits for the time period specified
by Transmit Delay Between Objects after the last packet is sent. The delay parameters are specified in
milliseconds. You may need to adjust these values (smaller buffers, longer delays) if communications is not
reliable, and you may if you wish adjust these values (larger buffers, smaller delays) to maximise data transfer
performance. If you adjust these values, please ensure that you test the transfer to ensure it is reliable,
otherwise you may risk losing data. Note: Some MIDI interfaces do not like large packet sizes: I recently
upgraded to a MOTU interface and ran into problems with MIDI export until I altered motif.factory to send
messages in small chunks defined by the above parameters!

Copying/Moving Data

In operation, using MIDI is quite straightforward.

You can get all the MIDI data into any Child Window (including the Motif Synthesizer Window) by selecting the
Import from MIDI option on the MIDI Menu, or the    button on the Tool Bar.

This imports all the data that you have set in the MIDI Preferences options to be included in bulk transfers.

Similarily you can also export all data using the Export MIDI option on the MIDI Menu, or the    button on
the Tool Bar.

Note if you import or export MIDI data to/from a Child Window which is opened from a data file, then the Motif
Synthesizer Window is also updated with the data being imported/exported.

You can also import/export individual Objects or a selection of Objects by selecting the Import/Export memory
options upon the Object's Context Sensitive Menu. You can also use the keyboard shortcuts for doing this.

And you can also move/copy Objects between the Motif Synthesizer Window and Child Window using drag
and drop.

You can also import/export a Object to/from the Motif Edit Buffer by selecting a single Object and selecting the
import/export to/from Motif Edit Buffer options from the Object's Context Sensitive Menu. You can also use

 Program Features 39



the keyboard shortcuts for doing this

Exporting Objects from motif.factory to the Motif Edit Buffer is really handy, for example, when trying to find a
particular Object in a file and you don't wish to load the file into the Motif.

Finally you can also perform all the operations on Objects in the Motif Synthesizer Window that you can upon
Objects in a normal Child Window.

If you have the Automatically Update Motif after Synth Window Edit option active, when you change data
the Motif Synthesizer Window then the changes are automatically exported to the Motif. If you are making a
lot of changes, you may find yourself waiting quite a lot during the time it takes to do these exports.

So you may wish to turn the  Automatically Update Motif after Synth Window Edit option off during
intensive editing sessions. Once you've made all your changes you then select the Export MIDI option on
the MIDI Menu, or the      button on the Tool Bar  Export option to manually export the changes.

If you quit motif.factory with changes still present in the Motif Synthesizer Window that have not been
exported, then you will be asked if you wish to export the data or not.

MIDI Keyboard Routing

motif.factory has a facility to allow MIDI data from an additional MIDI input port, defined in the MIDI
Preferences options dialog, to be routed to the port you have selected for motif.factory to output MIDI data on.
This allows, for example, you to use a master keyboard (which may be closer to your computer) to be used
when auditioning Motif sounds that you've sent from motif.factory to the Motif edit buffer.

You access this feature by selecting the Motif MIDI Router ... option in the  MIDI Menu or by pressing the F12
function key whenever you need it, which activates the following dialog.

The name of the menu option will change depending on the selected device.

The router uses the MIDI channel defined in the MIDI Preferences dialog This can either be the channel
transmitted by the source device, or the specified channel.

The routing is active until you close the dialog by selecting the Close Channel button or by pressing the ESC
key.
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Library Support
To use the motif.factory Library, your copy of motif.factory needs to be registered.

Configuring the Library

To configure the Library, go to the Library Preferences tab in the Preferences Dialog, and set up the
preferences for the Library.

Adding Objects to The Library

The following Objects can be added to the Library.

Synthesizer• 
Voices• 
Drum Voices• 
Plugin Voices• 
Performances• 
Multis• 
Masters• 
Arpeggios• 
Patterns• 
Songs• 
Song Chains• 
Mixing Voices• 
Waves• 

You can add Objects to the Library using the following methods:

Use the Add To Library function that can be found in an Object's context menu;• 
Drag Copy an Object or Selection of Objects over the Motif Library Window.• 
Using the copy and paste functions of the Clipboard.• 

Please note that you can only Drag Copy Objects to the Motif Library Window; you cannot Drag Move them.

Referenced objects are also copied to the Library if they are not already present in the Library. For example, if
you copy a Performance and it references Voices then they are also copied if required.

If an object is copied to the Library and it is already present in the library (either a complete match or just a
match in name), then the actions you have configured in the Library Preferences tab in the Preferences Dialog
are taken.

You can also Batch Import files to the library

Copying Objects From The Library

You can copy Objects from the Library to a file using the following methods:

Drag Copy an Object or Selection of Objects from the the Motif Library Window to a file.• 
Using the copy and paste functions of the Clipboard to copy an object from the Motif Library Window
and paste it to a destination file.

• 

Referenced objects are also copied from the Library if they are not already present in the destination file and if
the destination file supports them. For example, if you copy a Performance and it references Voices then they
are also copied if required.

Deleting Objects From The Library

To delete an object from the library, right click over the Object or selection of Objects and select the Delete
option from the context menu

Exporting Voices From The Library to the Motif

You can send Voices (Normal, Drum and Plugin) from the Library to the Motif edit buffer by right clicking over
a selected object and selecting the Export to Motif Edit Buffer option from the context menu.

You can also Drag Copy an Voice or Selection of Voices from the the Motif Library Window to the Motif Synth
Window

Extracting Files from the Library

If you set the Library Table View to show Files, you can right click over a file and select the Extract File menu
option, which will recreate the original file from all the source data held in the database. The file can then be
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saved. This option is also available for Files shown in the Library Tree View

List File Usage

If you right click over an object in the Library, and select the List File Usage... menu option, a dialog will be
displayed which shows all the files in the Library that make use of that object.

Several files may refer to a single object based on the setting on the Library import preferences if they are set
not to add identical objects. If this is set only a single copy is stored, and all files that contained the identical
object only refer to that single object within the Library

New Author

If you set the Library Table View to show Authors, you can right click in the Table and select the New Author
menu option, which displays a dialog that allows you to create a new Author. This option is also available in
the Library Tree View by right clicking over the Author branch

Library Information ...

Opens the Library Statistics dialog.
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Find and Goto Facilities
Find Dialog

motif.factory supports the ability to find Objects either by name or by category (where an Object supports
categories, such as Voices).

Searches start from the currently selected Object.

Selecting the Find ... option on the Edit Menu brings up the Find dialog, that allows you to specify the string to
search for. In addition there are several options that can be selected

Find What The text string to search for.
Match Case If this option is checked then the search is case sensitive. If this option is not checked then

the search is case insensitive.
Match Whole
Name

If this option is checked then the search string must match the entire name of an Object.
E.g. "pan" would match a Voice called "pan", but not a Voice called "pandora". If this option
is not checked then the search can match a sub string within a name. E.g. "dor" would
match a Voice named "dor" and a Voice called "pandora".

Use Wild Cards If checked motif.factory will treat the "Find What" text as a "regular expression" to allow you
more control over the search, such as matching text at the start of a name, or the end of a
name, words with numbers in, etc.

The regular expression language used for motif.factory wild card support is the Perl Regular Expression
Syntax. Rather than try and write up this powerful syntax myself into the motif.factory documents, I'll direct
you to the Perl Regular Expression Syntax page for a description of how to use this powerful feature.

Find Category Dialog

You can also search by category be selecting Find Category ... option on the Edit Menu, which brings up the
Find Category Dialog.

This option allows you to search, for example, for all string Voices in a file (assuming all Voices have been
assigned a category). Note: only some Objects (such as Voices and Performances) have a category value.

Simply select the Category from the "Find Category" combo box that you wish to search for, and that's all
there is to it.
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Goto Dialog

Selecting this option on the on the Edit Menu brings up the Goto Dialog

Item Type The type of Object to go to

The types of Objects that can be selected depends upon the type of file• 
If a Table View is selected then you can only go to the type of objects shown by
the Table

• 

Item Number The number of the Object to go to.

Note: At present Voice numbers can only be expressed in the 1-384 for the ES
Rack and 1-256 for the ES Keyboards. The dialog does not understand the
concept of Voice banks

• 

Note that Goto is not support in the Motif Library Window.
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Editing Features
motif.factory supports the following editing features:

General Editing Features• 
Synth Editing Features• 
Voice Editing Features• 
Drum Voice Editing Features• 
Plugin Voice Editing Features• 
Performance Editing Features• 
Multi Editing Features• 
Master Editing Features• 
Arpeggio Editing Features• 
Pattern Editing Features• 
Song Editing Features• 
Song Chain Editing Features• 
Mixing Voice Editing Features• 
Wave Editing Features• 
System Settings Editing Features• 
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General Editing Features

motif.factory supports many editing features, some of which are classed as general features that are
applicable to all or most Objects.

The general features are described here in one place for convenience:

Copy/Move Object• 
Initialise Object• 
Rename Object• 
Insert Object• 
Delete Object• 
List Object References• 
Sort Objects• 
Export Objects• 
Add Objects to Library• 

The following table shows whether or not a general edit operation can be applied to a particular type of
Object.

Please note:

The objects you can see depends on the type of synth (keyboard or rack). For example, the ES Rack
does not support Masters.

• 

The following table refers to ES Rack Multis; these are equivalent to ES Keyboard Mixing Templates.• 

Object Type Move Copy Initialise Rename Insert Delete List Sort Export Add To
Library

Synth Object Y Y Y N N N N N N Y
Voice Collection Y Y Y N N N N Y Y Y
Voice Y Y Y Y Y Y Y N N Y
Voice Element Collection Y Y Y N N N N N N N
Voice Element Y Y Y N Y Y N N N N
Voice Effects Unit Y Y Y N N N N N N N
Voice Reverb Effect Unit Y Y Y N N N N N N N
Voice Chorus Unit Y Y Y N N N N N N N
Voice Insert Effect Unit 1 Y Y Y N N N N N N N
Voice Insert Effect Unit 2 Y Y Y N N N N N N N
Voice Controller Collection Y Y Y N N N N N N N
Voice Controller Y Y Y N Y Y N N N N
Voice Default Arpeggio Y Y Y N N N N N N N
Voice Arpeggio Y Y Y N Y Y N N N N
Voice Audition Phrase Y Y Y N N N N N N N
Drum Voice Collection Y Y Y N N N N Y Y Y
Drum Voice Y Y Y Y Y Y Y N N Y
Drum Voice Drumkey Collection Y Y Y N N N N N N N
Drum Voice Drumkey Y Y Y N Y Y N N N N
Drum Voice Effects Unit Y Y Y N N N N N N N
Drum Voice Reverb Effect Unit Y Y Y N N N N N N N
Drum Voice Chorus Unit Y Y Y N N N N N N N
Drum Voice Insert Effect Unit 1 Y Y Y N N N N N N N
Drum Voice Insert Effect Unit 2 Y Y Y N N N N N N N
Drum Voice Controller Collection Y Y Y N N N N N N N
Drum Voice Controller Y Y Y N Y Y N N N N
Drum Voice Default Arpeggio Y Y Y N N N N N N N
Drum Voice Arpeggio Y Y Y N Y Y N N N N
Drum Voice Audition Phrase Y Y Y N N N N N N N
Plugin Voice Collection Y Y Y N N N N Y Y Y
Plugin Voice Y Y Y Y Y Y Y N N Y
Plugin Voice Effects Unit Y Y Y N N N N N N N
Plugin Voice Reverb Effect Unit Y Y Y N N N N N N N
Plugin Voice Chorus Unit Y Y Y N N N N N N N
Plugin Voice Insert Effect Unit 1 Y Y Y N N N N N N N
Plugin Voice Insert Effect Unit 2 Y Y Y N N N N N N N
Plugin Voice Controller Collection Y Y Y N N N N N N N
Plugin Voice Controller Y Y Y N Y Y N N N N
Plugin Voice Default Arpeggio Y Y Y N N N N N N N
Plugin Voice Arpeggio Y Y Y N Y Y N N N N
Plugin Voice Audition Phrase Y Y Y N N N N N N N
Performance Collection Y Y Y N N N N Y Y Y
Performance Y Y Y Y Y Y N N N Y
Performance Part Collection Y Y Y N N N N N N N
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Performance Part Y Y Y N Y Y N N N N
Performance Plugin Part Collection Y Y Y N N N N N N N
Performance Plugin Part Y Y Y N Y Y N N N N
Performance Effects Unit Y Y Y N N N N N N N
Performance Reverb Unit Y Y Y N N N N N N N
Performance Chorus Unit Y Y Y N N N N N N N
Performance Master EQ Unit Y Y Y N N N N N N N
Performance Master Effect Unit Y Y Y N N N N N N N
Performance Insert Effect Unit 1 Y Y Y N N N N N N N
Performance Insert Effect Unit 2 Y Y Y N N N N N N N
Performance Default Arpeggio Y Y Y N N N N N N N
Performance Arpeggio Y Y Y N Y Y N N N N
Performance Part Collection Y Y Y N N N N N N N
Performance Part Y Y Y N Y Y N N N N
Multi Collection Y Y Y N N N N Y Y Y
Multi Y Y Y Y Y Y N N N Y
Multi Part Collection Y Y Y N N N N N N N
Multi Part Y Y Y N Y Y N N N N
Multi Plugin Part Collection Y Y Y N N N N N N N
Multi Plugin Part Y Y Y N Y Y N N N N
Multi Effects Unit Y Y Y N N N N N N N
Multi Reverb Unit Y Y Y N N N N N N N
Multi Chorus Unit Y Y Y N N N N N N N
Multi Master EQ Unit Y Y Y N N N N N N N
Multi Master Effect Unit Y Y Y N N N N N N N
Multi Insert Effect Unit 1 Y Y Y N N N N N N N
Multi Insert Effect Unit 2 Y Y Y N N N N N N N
Multi Default Arpeggio Y Y Y N N N N N N N
Multi Arpeggio Y Y Y N Y Y N N N N
Multi AD Part Collection Y Y Y N N N N N N N
Multi AD Part Y Y Y N Y Y N N N N
Master Collection Y Y Y N N N N Y Y Y
Master Y Y Y Y Y Y N Y N Y
Master Zone Y Y Y N Y Y N N N N
Arpeggio Collection Y Y Y N N N N Y N Y
Arpeggio Y Y Y Y Y Y Y N N Y
Pattern Collection Y Y Y N N N N Y N Y
Pattern Y Y Y Y Y Y Y N N Y
Song Collection Y Y Y N N N N Y N Y
Song Y Y Y Y Y Y Y N N Y
Song Chain Collection Y Y Y N N N N N N Y
Song Chain Y Y Y N N N N N N Y
Mixing Voice Collection Y Y Y N N N N Y Y Y
Mixing Voice Y Y Y Y Y Y Y N N Y
Mixing Voice Element Collection Y Y Y N N N N N N N
Mixing Voice Element Y Y Y N Y Y N N N N
Mixing Voice Effects Unit Y Y Y N N N N N N N
Mixing Voice Reverb Effect Unit Y Y Y N N N N N N N
Mixing Voice Chorus Unit Y Y Y N N N N N N N
Mixing Voice Insert Effect Unit 1 Y Y Y N N N N N N N
Mixing Voice Insert Effect Unit 2 Y Y Y N N N N N N N
Mixing Voice Controller Collection Y Y Y N N N N N N N
Mixing Voice Controller Y Y Y N Y Y N N N N
Mixing Voice Default Arpeggio Y Y Y N N N N N N N
Mixing Voice Arpeggio Y Y Y N Y Y N N N N
Mixing Voice Audition Phrase Y Y Y N N N N N N N
Wave Collection Y Y Y N N N N Y N Y
Wave Y Y Y Y Y Y Y N N Y
System Settings Y Y Y N N N N N N N
System Settings Effects Unit Y Y Y N N N N N N N
System Settings Master EQ Unit Y Y Y N N N N N N N
System Settings Master Effect Unit Y Y Y N N N N N N N
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Copy/Move Object

motif.factory makes extensive use of drag and drop for copying and moving Objects.

You can drag copy or move Objects within a file or between files, and you can drag single items or multiple
items.

The default drag operation is to move an Object, and there are two types of move operations:

Moving an Object within its Parent Collection (e.g. moving a Voice from location 1 to location 4)• 
Moving an Object to a new Parent Collection (e.g. moving a Voice from one file to another file)• 

When you move an Object to a new Parent Collection then the original Object is removed and replaced with
an initialised Object of the same type. 

To copy an Object using drag and drop, you must have the DRAG MODIFIER key held down during the
operation. The DRAG MODIFIER key is platform dependent. On the PC platform it is the CTRL key.

You can tell that a copy operation is in progress as the drag image icon has a + sign visible. 

When you drag multiple items they must be of the same type. For example you can drag several Voices, but
not Voices and Performances together.

motif.factory provides the following drag/drop feedback to assist in determining the effects of a drag/drop
operation:

Cursor: Indicates if the move is either a copy or a move, or if the drop is invalid (e.g. trying to drag a
Voice onto an Element)

• 

Drag image: A simple pictorial representation of what is being dragged• 
Drop Point: motif.factory shows the drop point as either a cue line drawn between Objects if an Object
is being moved within its parent (e.g. an Element within a Voice), or a cue rectangle drawn around the
drop location for all other moves and copy operations which are valid

• 

When a Child Window is split, Objects can be dragged and dropped between either side of the split point.
This is handy, for example, for dragging Objects between the start of a Collection and the end of a Collection.

The Tree and Table views will auto-scroll in drag and drop operations, when you move the cursor to either the
top or the bottom of the pane and hold it there.

If you drag an Object onto a Tree View and over a valid parent Object (e.g. an Element over a Voice) and the
parent Object is collapsed within the Tree, and you hold the cursor over the Parent Object for a few seconds it
will automatically expand.

motif.factory will maintain the references to Objects in a Collection when moving Objects within a file, as
follows: 

Collection Type Objects Updated
Voice Drum Voice Keys

Performance Parts
Multi Parts
Masters
Song/Pattern Mixing Channels

Drum Voice Performance Parts
Multi Parts
Masters
Song/Pattern Mixing Channels

Plugin Voice Performance Plugin Parts
Multi Plugin Parts
Masters
Song/Pattern Mixing Channels

User Arpeggios Voices
Drum Voices
Plugin Voices
Performances
Multis, Mixes
Mixing Voices

Songs Song Chains
Masters

Patterns Masters
Mixing Voices Song Mixes

Pattern Mixes
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Waves Voices
Drum Voices
Song Mixes
Pattern Mixes

For example if you move a Voice within an file from Location 2 to Location 10, then any Performance Parts
which are referencing Voices at Locations 2 and above will be updated to ensure they still reference the same
Voices after the move operation as they were before the move operation.

The ability to update references following a move or to copy referenced Objects during a move to a new file
can be selectively turned on or off within the Preferences Dialog.

When you are dragging certain Objects that can only be copied and not moved, don't forget that you need to
hold down the  DRAG MODIFIER key for the drag to be valid. For example, if you are dragging a preset Voice
from the Motif Synthesizer Window onto a Performance Part then you must be performing a copy operation.

Here is a list of items that can only be copied and not moved

Preset Voices• 
Preset Drum Voices• 
Preset GM Voices• 
Preset GM Drum Voices• 
Preset Waves• 
Preset Arpeggios• 
Preset Audition Phrases• 
User Voices when dragged onto Performance Parts, Multi Parts, Drum Keys, Masters, Song Mixes or
Pattern Mixes

• 

User Drum Voices when dragged onto Performance Parts, Multi Parts, Drum Keys, Masters, Song
Mixes or Pattern Mixes

• 

User Plugin Voices when dragged onto Performance Parts, Multi Parts, Drum Keys, Song Mixes or
Pattern Mixes

• 

User Arpeggios when dragged onto Voices, Drum Voices, Plugin Voices, Performances, Multis or
Mixing Voices

• 

User Songs when dragged onto Song Chains or Masters• 
User Patterns when dragged onto Masters• 
User Mixing Voices when dragged onto Song/Pattern Mix Tracks• 
User Waves when dragged onto Voice Elements, Drum Keys or Song/Pattern Mix Tracks• 

Initialise Object

Initialises the selected Object to its default state.

Multiple Objects of the same type can be selected for initialisation.

The  Initialise command is found upon the Context Sensitive Menu in both the Tree View and the Table
View.

Rename Object

Renames the selected Object using the following dialog:

Only one Object can be selected for renaming.

The dialog will provide drop down lists for selecting Category and Sub Category names for Objects that
support them:

Object Type Category?
Voice Yes
Drum Voice Yes
Plugin Voice Yes
Performance Yes
Multi No
Master No
Arpeggio Yes
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Master No
Song No
Pattern No
Mixing Voice Yes
Wave Yes
The  Rename command is found upon the Context Sensitive Menu in the Tree View

To rename Objects in the Table View, simply click in the Category Cell of the required Object to select the
Category value from a drop down list, click in the Sub Category Cell of the required Object to select the Sub
Category value from a drop down list, or double click in the Name Cell of the required Object to edit the name.

Insert Object

Inserts an Object into a Collection at the current location.

The  Insert command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

You can insert more than one Object at a time by selecting multiple Objects prior to executing the Insert
command.

For example if you wish to insert three Performances at location 10, select Performances 10, 11 and 12 and
then execute the Insert command.

Note that when you insert one or more Objects, then the commensurate number of Objects at the end of the
Parent Collection are removed if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, a Voice Collection in an Motif ES Rack file can only contain 384 Voices, so if two Voices are
inserted into the Collection then two Voices must be removed from the end of the Collection to maintain the
correct size.

motif.factory will maintain the references to Objects in a Collection when inserting Objects, as follows: 

Collection Type Objects Updated
Voice Drum Voice Keys

Performance Parts
Multi Parts
Masters
Song/Pattern Mixing Channels

Drum Voice Performance Parts
Multi Parts
Masters
Song/Pattern Mixing Channels

Plugin Voice Performance Plugin Parts
Multi Plugin Parts
Masters
Song/Pattern Mixing Channels

User Arpeggios Voices
Drum Voices
Plugin Voices
Performances
Multis, Mixes
Mixing Voices

Songs Song Chains
Masters

Patterns Masters
Mixing Voices Song Mixes

Pattern Mixes
Waves Voices

Drum Voices
Song Mixes
Pattern Mixes

For example if you insert a Voice into an file at Location 10, then any Performance Parts which are
referencing Voices at Locations 10 and above will be updated to ensure they still reference the same Voices
after the insert operation as they were before the insert operation.

Delete Object

Deletes an Object at the current location.

The  Delete command is found upon the Context Sensitive Menu in both the Tree View and the Table View.
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You can delete more than one Object at a time by selecting multiple Objects prior to executing the  Delete
command.

For example if you wish to delete three Performances at location 10, select Performances 10, 11 and 12 and
then execute the  Delete command.

Note that when you delete one or more Objects, then a commensurate number of Objects at the end of the
Parent Collection are added if required. This is necessary to maintain the correct number of Objects in a
Collection.

For example, a Voice Collection in a Motif ES Rack file must contain 384 Voices, so if two Voices are deleted
from the Collection then two Voices must be added to the end of the Collection to maintain the correct size.

motif.factory will maintain the references to Objects in a Collection when deleting Objects, as follows: 

Collection Type Objects Updated
Voice Drum Voice Keys

Performance Parts
Multi Parts
Masters
Song/Pattern Mixing Channels

Drum Voice Performance Parts
Multi Parts
Masters
Song/Pattern Mixing Channels

Plugin Voice Performance Plugin Parts
Multi Plugin Parts
Masters
Song/Pattern Mixing Channels

User Arpeggios Voices
Drum Voices
Plugin Voices
Performances
Multis, Mixes
Mixing Voices

Songs Song Chains
Masters

Patterns Masters
Mixing Voices Song Mixes

Pattern Mixes
Waves Voices

Drum Voices
Song Mixes
Pattern Mixes

For example if you delete a Voice from a file at Location 10, then any Performance Parts which are
referencing Voices at Locations 10 and above will be updated to ensure they still reference the same Voices
after the delete operation as they were before the delete operation.

List Object References

The  List References command is found upon the Context Sensitive Menu in both the Tree View and
the Table View.

The List References command is only available if:

Only one Object is selected• 
The Object selected is referenced by another Object, which is indicated by the Object being coloured
blue

• 

The references are shown as follows:

The Object being referenced is shown at the top of the Dialog followed by the Objects referencing it.
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Sort Objects

The  Sort command is found upon the Context Sensitive Menu in both the Tree View and the Table View.

The type of sort operations available depend upon the types of Object being sorted:

Object Type Sort by Name Sort By
Category

Voices Yes Yes
Drum Voices Yes Yes
Plugin Voices Yes Yes
Performances Yes Yes
Multis Yes No
Masters Yes No
Arpeggios Yes No
Songs Yes No
Patterns Yes No
Mixing Voices Yes Yes
Waves Yes No
In the Tree View the sort options are accessed via the Context Sensitive Menu for the Collection that you
wish to sort (e.g. the Voice Collection to sort Voices).

In the Table View the sort options are accessed via the Context Sensitive Menu for any Object. The sort can
also be initiated by clicking in the Category or Name column headers.
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Synth Editing Features

motif.factory supports the following editing operations upon the Synth Object within the Tree View of a Child
Window:

Move• 
Copy• 
Initialise• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access these features, right click over the Synth Object to activate the Synth Object's Context Sensitive
Menu.

The Synth Object is only shown within a Tree View  and is the first Object in the Tree View. Its name
identifies the type of file.

For example, a Synth Object representing an SYSEX file is labelled:

SYSEX File

Import from Motif Memory

Imports data from the Motif Memory locations into the currently selected Child Window.

Export to Motif Memory

Exports data from the currently selected Child Window to the Motif Memory locations.
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Voice Editing Features

motif.factory supports the following editing operations upon the Voice Collection shown within the Tree View
of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Save As W7E File (W7A and Sysex files only)• 
Save As W7V File (W7A and Sysex files only)• 
Save As W9E File (W7A and Sysex files only)• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Voice Collection Object in a file is only shown within a Tree View and is called User Voices.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voice Collection to activate the Voice Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Voice Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Import from Motif Edit Buffer• 
Export to Motif Edit Buffer (only if available motif.factory is registered and MIDI support is enabled)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Voice
or selection of Voices to activate the Voice's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a Voice :

Voice Elements• 
Voice Controllers• 
Voice Effects• 
Voice Arpeggiator Unit• 
Voice Audition Unit (Motif ES Rack)• 

Import from Motif Memory

Imports Voices from the Motif Memory locations into the currently selected Child Window.

You can import:

A Single Voice• 
A Selection of Voices• 
All Voices by selecting the Voice Collection• 

Export to Motif Memory

Exports Voices from the currently selected Child Window to the Motif Memory locations.

You can export:

A Single Voice• 
A Selection of Voices• 
All Voices by selecting the Voice Collection• 
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Import from Motif Edit Buffer

Imports the Voice currently in the Motif Edit Buffer (i.e. the currently selected Voice on the Motif) into the Voice
currently selected within the active Child Window.

Note if you have more than one Voice selected then this operation is not available.

Export to Motif Edit Buffer

Exports the Voice currently selected within the active Child Window to the Motif Edit Buffer.

Note if you have more than one Voice selected then this operation is not available.

Voice Element Editing Features

motif.factory supports the following editing operations upon the Voice Element Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Voice Element Collection to activate the  Voice Element Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Voice Element Objects within the Tree
View of a Child Window:

Copy/Move• 
Set Wave• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Voice  Element or selection of Voices Elements to activate the  Voice Element's Context Sensitive Menu.

Set Wave

The Wave for an AWM Element can be set by drag copying a Preset Wave onto the Element.

In a W7A or W7V file you can also drag copy a User Wave onto the Element.

Please note, the drag operation for this is COPY only. E.g. you cannot MOVE a Preset Wave onto an
Element.

Voice Effects Editing Features

motif.factory supports the following editing operations upon the Voice Effects Units Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voice Effects Units Collection to activate the Voice Effects Units Collection's Context Sensitive Menu.

A Voice Effects Collection can also be moved/copied via drag and drop to Drum Voices, Plugin Voices,
Performances and Multis. If a Voice Effects Collection is copied to a Performance or Multi  then only the
child Reverb and Chorus Effects units are copied.

motif.factory supports the following editing operations upon the individual Voice Effects Objects (Reverb,
Chorus, INS1 and INS2 effects units) within the Tree View of a Child Window:
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Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Voice Effect or selection of  Voice Effects to activate the Voice Effects's Context Sensitive Menu.

Voice Effects can also be copied/moved via drag and drop to the corresponding effect type in Drum Voices,
Plugin Voices, Performances and Multis and the System Master Effects. A Voice Insert Effect can be copied
to a Performance, Multi or System Master Effect.

Voice Controller Editing Features

motif.factory supports the following editing operations upon the Voice Controllers Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Voice Controllers Collection to activate the Voice Controllers Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Voice Controller Objects within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Voice
Controller or selection of Voice Controllers to activate the Voice Controller's Context Sensitive Menu.

Voice Arpeggiator Editing Features

motif.factory supports the following editing operations upon the Voice Arpeggiator Object shown within
the Tree View of a Child Window:

Copy/Move• 
Set Arpeggio• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Voice Arpeggiator to activate the  Voice Arpeggiator's Context Sensitive Menu.

You can Copy/Move  Voice Arpeggiators to/from Drum Voice Arpeggiators, Plugin Voice Arpeggiators,
Performance Arpeggiators and Multi Arpeggiators as well as  Voice Arpeggiators.

A Motif Arpeggiator Unit as shown in the Tree View shows the default arpeggio that plays when the Voice is
first selected, and the five selectable arpeggios are shown as Child Objects. The following operations can be
carried out on the five arpeggios

Copy/Move• 
Set Arpeggio• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

You can also drag copy one of the five arpeggios onto the Arpeggio unit to set the default arpeggio.Please
note, the drag operation for this is COPY only. 
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Set Arpeggio

Preset Arpeggios from the Motif Synthesizer Window can be dragged onto a Voice's Arpeggiator.

You can also drag copy a User Arpeggio in a W7A file onto a Voice's Arpeggiator as well (assuming the Voice
is in the same W7A file).

Please note, the drag operation for this is COPY only. You cannot MOVE an Arpeggio onto an Arpeggiator.

Voice Audition Unit Editing Features

motif.factory supports the following editing operations upon the Voice Audition Unit Object shown within
the Tree View of a Child Window:

Copy/Move• 
Set Audition Phrase• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Voice Audition  Unit to activate the  Voice Audition Unit's Context Sensitive Menu.

You can Copy/Move  Voice Audition Units to Drum Voices and Plugin Voices.

Set Audition Phrase

Preset Audition Phrases from the Motif Synthesizer Window can be dragged onto a Voice's Audition Unit.
Please note, the drag operation for this is COPY only. You cannot MOVE an Audition Phrase onto an Audition
Unit.
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Drum Voice Editing Features

motif.factory supports the following editing operations upon the Drum Voice Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Save As W7E File (W7A and Sysex files only)• 
Save As W7V File (W7A and Sysex files only)• 
Save As W9E File (W7A and Sysex files only)• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Drum Voice Collection Object in a file is only shown within a Tree View and is called User Drum
Voices.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drum Voice Collection to activate the Drum Voice Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Drum Voice Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Import from Motif Edit Buffer• 
Export to Motif Edit Buffer (only if available motif.factory is registered and MIDI support is enabled)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Drum
Voice or selection of Drum Voices to activate the Drum Voice's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a Drum
Voice :

Drum Voice Drumkeys• 
Drum Voice Controllers• 
Drum Voice Effects• 
Drum Voice Arpeggiator Unit• 
Drum Voice Audition Unit (Motif ES Rack)• 

Import from Motif Memory

Imports Drum Voices from the Motif Memory locations into the currently selected Child Window.

You can import:

A Single Drum Voice• 
A Selection of Drum Voices• 
All Drum Voices by selecting the Drum Voice Collection• 

Export to Motif Memory

Exports Drum Voices from the currently selected Child Window to the Motif Memory locations.

You can export:

A SingleDrum  Voice• 
A Selection of Drum Voices• 
All Drum Voices by selecting the Drum Voice Collection• 
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Import from Motif Edit Buffer

Imports the Drum Voice currently in the Motif Edit Buffer (i.e. the currently selected Drum Voice on the Motif)
into the Drum Voice currently selected within the active Child Window.

Note if you have more than one Drum Voice selected then this operation is not available.

Export to Motif Edit Buffer

Exports the Drum Voice currently selected within the active Child Window to the Motif Edit Buffer.

Note if you have more than one Drum Voice selected then this operation is not available.

Drum Voice Drumkey Editing Features

motif.factory supports the following editing operations upon a Drum Voice 's Drumkey Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drumkey Collection to activate the Drumkey Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Drumkey Objects within the Tree View of
a Child Window:

Copy/Move• 
Set Wave/Voice• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Drumkey or selection of Drumkeys to activate the Drumkey's Context Sensitive Menu.

Set Wave/Voice

The Wave or Voice for an AWM Drumkey can be set by drag copying a Preset Wave or Voice onto the
Drumkey.

In a W7A or W7V file you can also drag copy a User Wave or User Voice onto the Drum Key.

Please note, the drag operation for this is COPY only. E.g. you cannot MOVE a Preset Wave onto a Drum
Key.

Drum Voice Effects Editing Features

motif.factory supports the following editing operations upon the Drum Voice Effects Units Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drum Voice Effects Units Collection to activate the Drum Voice Effects Units Collection's Context
Sensitive Menu.

A Drum Voice Effects Collection can also be moved/copied via drag and drop to Voices, Plugin Voices,
Performances and Multis. If a Drum Voice Effects Collection is copied to a Performance or Multi  then only
the child Reverb and Chorus Effects units are copied.
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motif.factory supports the following editing operations upon the individual Drum Voice Effects Objects
(Reverb, Chorus, INS1 and INS2 effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Drum
Voice Effect or selection of  Drum Voice Effects to activate the Drum Voice Effects's Context Sensitive
Menu.

Drum Voice Effects can also be copied/moved via drag and drop to the corresponding effect type in Voices,
Plugin Voices, Performances and Multis and the System Master Effects. A Voice Insert Effect can be copied
to a Performance, Multi or System Master Effect.

Drum Voice Controller Editing Features

motif.factory supports the following editing operations upon the Drum Voice Controllers Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Drum Voice Controllers Collection to activate the Drum Voice Controllers Collection's Context Sensitive
Menu.

motif.factory supports the following editing operations upon the Drum Voice Controller Objects within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Drum
Voice Controller or selection of Drum Voice Controllers to activate the Drum Voice Controller's Context
Sensitive Menu.

Drum Voice Arpeggiator Editing Features

motif.factory supports the following editing operations upon the Drum Voice Arpeggiator Object shown within
the Tree View of a Child Window:

Copy/Move• 
Set Arpeggio• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Drum Voice Arpeggiator to activate the  Drum Voice Arpeggiator's Context Sensitive Menu.

You can Copy/Move  Drum Voice Arpeggiators to/from Voice Arpeggiators, Plugin Voice Arpeggiators,
Performance Arpeggiators and Multi Arpeggiators as well as Drum Voice Arpeggiators.

A Motif Arpeggiator Unit as shown in the Tree View shows the default arpeggio that plays when the Drum
Voice is first selected, and the five selectable arpeggios are shown as Child Objects. The following operations
can be carried out on the five arpeggios

Copy/Move• 
Set Arpeggio• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
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Copy to Clipboard• 
Paste from Clipboard• 

You can also drag copy one of the five arpeggios onto the Arpeggio unit to set the default arpeggio.Please
note, the drag operation for this is COPY only. 

Set Arpeggio

Preset Arpeggios from the Motif Synthesizer Window can be dragged onto a Drum Voice's Arpeggiator.

You can also drag copy a User Arpeggio in a W7A file onto a Drum Voice's Arpeggiator as well (assuming the
Drum Voice is in the same W7A file).

Please note, the drag operation for this is COPY only. You cannot MOVE an Arpeggio onto an Arpeggiator.

Drum Voice Audition Unit Editing Features

motif.factory supports the following editing operations upon the Drum Voice Audition Unit Object shown
within the Tree View of a Child Window:

Copy/Move• 
Set Audition Phrase• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Drum Voice Audition  Unit to activate the  Drum Voice Audition Unit's Context Sensitive Menu.

You can Copy/Move Drum Voice Audition Units to Voices and Plugin Voices.

Set Audition Phrase

Preset Audition Phrases from the Motif Synthesizer Window can be dragged onto a Drum Voice's Audition
Unit. Please note, the drag operation for this is COPY only. You cannot MOVE an Audition Phrase onto an
Audition Unit.
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Plugin Voice Editing Features

motif.factory supports the following editing operations upon the Plugin Voice Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Save As W7E File (W7A and Sysex files only)• 
Save As W7V File (W7A and Sysex files only)• 
Save As W9E File (W7A and Sysex files only)• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Plugin Voice Collection Object in a file is only shown within a Tree View and is called User Plugin
Voices.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Plugin Voice Collection to activate the Plugin Voice Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Plugin Voice Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Import from Motif Edit Buffer• 
Export to Motif Edit Buffer (only if available motif.factory is registered and MIDI support is enabled)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Plugin Voice or selection of Plugin Voices to activate the Plugin Voice's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a Plugin
Voice :

Plugin Voice Controllers• 
Plugin Voice Effects• 
Plugin Voice Arpeggiator Unit• 
Plugin Voice Audition Unit (Motif ES Rack)• 

Import from Motif Memory

Imports Plugin Voices from the Motif Memory locations into the currently selected Child Window.

You can import:

A Single Plugin Voice• 
A Selection of Plugin Voices• 
All Plugin Voices by selecting the Plugin Voice Collection• 

Export to Motif Memory

Exports Plugin Voices from the currently selected Child Window to the Motif Memory locations.

You can export:

A SinglePlugin  Voice• 
A Selection of Plugin Voices• 
All Plugin Voices by selecting the Plugin Voice Collection• 
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Import from Motif Edit Buffer

Imports the Plugin Voice currently in the Motif Edit Buffer (i.e. the currently selected Plugin Voice on the Motif)
into the Plugin Voice currently selected within the active Child Window.

Note if you have more than one Plugin Voice selected then this operation is not available.

Export to Motif Edit Buffer

Exports the Plugin Voice currently selected within the active Child Window to the Motif Edit Buffer.

Note if you have more than one Plugin Voice selected then this operation is not available.

Plugin Voice Effects Editing Features

motif.factory supports the following editing operations upon the Plugin Voice Effects Units Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Plugin Voice Effects Units Collection to activate the Plugin Voice Effects Units Collection's Context
Sensitive Menu.

A Plugin Voice Effects Collection can also be moved/copied via drag and drop to Voices, Drum Voices,
Performances and Multis. If a Plugin Voice Effects Collection is copied to a Performance or Multi  then only
the child Reverb and Chorus Effects units are copied.

motif.factory supports the following editing operations upon the individual Plugin Voice Effects Objects
(Reverb, Chorus, INS1 and INS2 effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Plugin Voice Effect or selection of  Plugin Voice Effects to activate the Plugin Voice Effects's Context
Sensitive Menu.

Plugin Voice Effects can also be copied/moved via drag and drop to the corresponding effect type in Voices,
Drum Voices, Performances and Multis and the System Master Effects. A Voice Insert Effect can be copied to
a Performance, Multi or System Master Effect.

Plugin Voice Controller Editing Features

motif.factory supports the following editing operations upon the Plugin Voice Controllers Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Plugin Voice Controllers Collection to activate the Plugin Voice Controllers Collection's Context
Sensitive Menu.

motif.factory supports the following editing operations upon the Plugin Voice Controller Objects within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 
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To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Plugin Voice Controller or selection of Plugin Voice Controllers to activate the Plugin Voice Controller's
Context Sensitive Menu.

Plugin Voice Arpeggiator Editing Features

motif.factory supports the following editing operations upon the Plugin Voice Arpeggiator Object shown
within the Tree View of a Child Window:

Copy/Move• 
Set Arpeggio• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Plugin Voice Arpeggiator to activate the  Plugin Voice Arpeggiator's Context Sensitive Menu.

You can Copy/Move  Plugin Voice Arpeggiators to/from Voice Arpeggiators, Drum Voice Arpeggiators,
Performance Arpeggiators and Multi Arpeggiators as well as Plugin Voice Arpeggiators.

A Motif Arpeggiator Unit as shown in the Tree View shows the default arpeggio that plays when the Plugin
Voice is first selected, and the five selectable arpeggios are shown as Child Objects. The following operations
can be carried out on the five arpeggios

Copy/Move• 
Set Arpeggio• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

You can also drag copy one of the five arpeggios onto the Arpeggio unit to set the default arpeggio.Please
note, the drag operation for this is COPY only. 

Set Arpeggio

Preset Arpeggios from the Motif Synthesizer Window can be dragged onto a Plugin Voice's Arpeggiator.

You can also drag copy a User Arpeggio in a W7A file onto a Plugin Voice's Arpeggiator as well (assuming
the Plugin Voice is in the same W7A file).

Please note, the drag operation for this is COPY only. You cannot MOVE an Arpeggio onto an Arpeggiator.

Plugin Voice Audition Unit Editing Features

motif.factory supports the following editing operations upon the Plugin Voice Audition Unit Object shown
within the Tree View of a Child Window:

Copy/Move• 
Set Audition Phrase• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Plugin Voice Audition  Unit to activate the  Plugin Voice Audition Unit's Context Sensitive Menu.

You can Copy/Move Plugin Voice Audition Units to Voices and Drum Voices.

Set Audition Phrase

Preset Audition Phrases from the Motif Synthesizer Window can be dragged onto a Plugin Voice's Audition
Unit. Please note, the drag operation for this is COPY only. You cannot MOVE an Audition Phrase onto an
Audition Unit.
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Performance Editing Features

motif.factory supports the following editing operations upon the  Performance Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Performance Collection Object in a file is only shown within a Tree View and is called User
Performances.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Collection to activate the Performance Collection's Context Sensitive Menu.

Note: You can copy a Performance Collection to a Multi Collection. The parts in each Performance are
copied to the first four parts in the corresponding Multi.

motif.factory supports the following editing operations upon the Performance Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Import from Motif Edit Buffer• 
Export to Motif Edit Buffer (only if available motif.factory is registered and MIDI support is enabled)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Performance or selection of Performance to activate the Performance's Context Sensitive Menu.

Note: You can copy a Performance to a Multi. The parts in the Performance are copied to the first four parts
in the destination Multi.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a
Performance:

Performance Parts• 
Performance Plugin Parts• 
Performance Effects• 
Performance Arpeggiator Unit• 
Performance AD Parts (Motif ES Keyboard)• 

Import from Motif Memory

Imports Performances from the Motif Memory locations into the currently selected Child Window.

You can import:

A Single Performance• 
A Selection of Performances• 
All Performances by selecting the Performance Collection• 

Export to Motif Memory

Exports Performances from the currently selected Child Window to the Motif Memory locations.

You can export:
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A Single Performance• 
A Selection of Performances• 
All Performances by selecting the Performance Collection• 

Import from Motif Edit Buffer

Imports the Performance currently in the Motif Edit Buffer (i.e. the currently selected Performance on the
Motif) to the Performance currently selected within the active Child Window.

Note if you have more than one Performance selected then this operation is not available.

Export to Motif Edit Buffer

Exports the Performance currently selected within the active Child Window to the Motif Edit Buffer.

Note if you have more than one Performance selected then this operation is not available.

Performance Part Editing Features

motif.factory supports the following editing operations upon the Performance Part Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Performance Part Collection to activate the  Performance Part Collection's Context Sensitive Menu.

Note: You can copy a Performance Part Collection to a Multi Part Collection. The parts in each
Performance are copied to the first four parts in the corresponding Multi.

motif.factory supports the following editing operations upon the Performance Part Objects within the Tree
View of a Child Window:

Copy/Move• 
Set Voice• 
Initialise• 
Insert• 
Delete• 
Set/Clear Layer Switch• 
Set/Clear Insert Switch• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Performance Part or selection of Performance Parts to activate the  Performance Part 's Context Sensitive
Menu.

Note: You can copy a Performance Part to a Multi Part.

Set Voice

A User Voice from the same file can be dragged onto a Performance Part to set the Voice used by the
Performance Part.

Preset Voices from the Motif Synthesizer Window can be dragged onto Performance Parts as well.

Please note, the drag operation for this is COPY only. You cannot MOVE a Voice onto a Performance Part.

Set/Clear Layer Switch

The Set/Clear Layer Switch options can be found on the Performance Part 's Context Sensitive Menu.

Using the available options you can:

Set the Layer Switch for the Part, as long as the maximum number of allowed Layer Switches is not
exceeded

• 

Clear the Layer Switch for the Part• 
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Note: this command is not available if more than one Performance Part is selected.

Set Clear Insert Switch

The Set/Clear Layer Switch options can be found on the Performance Part 's Context Sensitive Menu.

Using the available options you can:

Set the Insert Switch for the Part, as long as the maximum number of allowed Insert Switches is not
exceeded

• 

Clear the Insert Switch for the Part• 

Note: this command is not available if more than one Performance Part is selected.

Performance Plugin Part Editing Features

motif.factory supports the following editing operations upon the Performance Plugin Part Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Performance Plugin Part Collection to activate the  Performance Part Collection's Context Sensitive
Menu.

Note: You can copy a Performance Plugin Part Collection to a Multi Plugin Part Collection.

motif.factory supports the following editing operations upon the Performance Plugin Part Objects within
the Tree View of a Child Window:

Copy/Move• 
Set Plugin Voice• 
Initialise• 
Insert• 
Delete• 
Set/Clear Insert Switch• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Performance Plugin Part or selection of Performance Plugin Parts to activate the  Performance Plugin
Part 's Context Sensitive Menu.

Note: You can copy a Performance Plugin Part to a Multi Plugin Part.

Set Plugin Voice

A User Plugin Voice from the same file can be dragged onto a Performance Plugin Part to set the Plugin
Voice used by the Performance Plugin Part.

Please note, the drag operation for this is COPY only. You cannot MOVE a Voice onto a Performance Part.

Set Clear Insert Switch

The Set/Clear Layer Switch options can be found on the Performance Plugin Part 's Context Sensitive
Menu.

Using the available options you can:

Set the Insert Switch for the Part, as long as the maximum number of allowed Insert Switches is not
exceeded

• 

Clear the Insert Switch for the Part• 

Note: this command is not available if more than one Performance Plugin Part is selected.

Performance Effects Editing Features

motif.factory supports the following editing operations upon the Performance Effects Units Collection
shown within the Tree View of a Child Window:
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Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Performance Effects Units Collection to activate the Performance Effects Units Collection's Context
Sensitive Menu.

A Performance Effects Collection can also be moved/copied via drag and drop to Voice, Drum Voice,
Plugin Voices, Multis and the System Master Effects. If a Performance Effects Collection is copied to a
Voice then the child Reverb and Chorus Effects units are copied, and the Master Effect is copied/moved to the
first Insert Effect.

motif.factory supports the following editing operations upon the individual Performance Effects Objects
(Reverb, Chorus, Master EQ and Master effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Performance Effect or selection of Performance Effects to activate the Performance Effects's Context
Sensitive Menu.

Performance Effects can also be copied/moved via drag and drop to the corresponding effect type in Voices,
Drum Voices, Plugin Voices, Multis and the System Master Effects. A Performance Master Effect can be
copied to a Voice, Drum Voice or Plugin Voice Insert Effect.

Motif ES Keyboard Performance Insert Effect Units are also supported.

Performance Arpeggiator Editing Features

motif.factory supports the following editing operations upon the Performance Arpeggiator Object shown
within the Tree View of a Child Window:

Copy/Move• 
Set Arpeggio• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Performance Arpeggiator to activate the  Performance Arpeggiator's Context Sensitive Menu.

You can Copy/Move  Performance Arpeggiators to/from Voice Arpeggiators, Drum Voice Arpeggiators,
Plugin Voice Arpeggiators and Multi Arpeggiators as well as Performance Arpeggiators.

A Motif Arpeggiator Unit as shown in the Tree View shows the default arpeggio that plays when the
Performance is first selected, and the five selectable arpeggios are shown as Child Objects. The following
operations can be carried out on the five arpeggios

Copy/Move• 
Set Arpeggio• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

You can also drag copy one of the five arpeggios onto the Arpeggio unit to set the default arpeggio.Please
note, the drag operation for this is COPY only. 

Set Arpeggio

Preset Arpeggios from the Motif Synthesizer Window can be dragged onto a Performance's Arpeggiator.

You can also drag copy a User Arpeggio in a W7A file onto a Performance's Arpeggiator as well (assuming
the Performance is in the same W7A file).
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Please note, the drag operation for this is COPY only. You cannot MOVE an Arpeggio onto an Arpeggiator.

Performance AD Part Editing Features

Note: AD Parts are not supported by the Motif Rack ES.

motif.factory supports the following editing operations upon the Performance AD Part Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Performance AD Part Collection to activate the  Performance AD Part Collection's Context Sensitive
Menu.

Note: You can copy a Performance AD Part Collection to a Multi AD Part Collection.

motif.factory supports the following editing operations upon the Performance AD Part Objects within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Performance AD Part or selection of Performance AD Parts to activate the  Performance AD Part 's
Context Sensitive Menu.

Note: You can copy a Performance AD Part to a Multi AD Part.
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Multi (Mix) Editing Features

Note: a Multi on a Motif ES Rack is equivalent to both a Mix in a Song or Pattern and a Mixing Template on
the Motif ES Keyboards. A Multi Part is equivalent to a Mix Track. For brevity, this documentation just refers
to Multis and Multi Parts.

In an ES keyboard W7A file, the Mixing Templates are shown as a seperate collection in the same way that
ES Rack multis are.

motif.factory supports the following editing operations upon the  Multi Collection shown within the Tree View
of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Multi Collection Object in a file is only shown within a Tree View and is called User Multis.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Multi Collection to activate the Multi Collection's Context Sensitive Menu.

Note: You can copy a Multi Collection to a Performance Collection. The first four parts in each Multi are
copied to the parts in the corresponding Performance.

motif.factory supports the following editing operations upon the Multi Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Import from Motif Edit Buffer• 
Export to Motif Edit Buffer (only if available motif.factory is registered and MIDI support is enabled)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Multi
or selection of Multi to activate the Multi's Context Sensitive Menu.

Note: You can copy a Multi to a Performance. The first four parts in the Multi are copied to the parts in the
destination Multi.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a Multi:

Multi Parts• 
Multi Plugin Parts• 
Multi Effects• 
Multi Arpeggiator Unit• 
Multi AD Parts (Motif ES Keyboard)• 

Import from Motif Memory

Imports Multis from the Motif Memory locations into the currently selected Child Window.

You can import:

A Single Multi• 
A Selection of Multis• 
All Multis by selecting the Multi Collection• 
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Export to Motif Memory

Exports Multis from the currently selected Child Window to the Motif Memory locations.

You can export:

A Single Multi• 
A Selection of Multis• 
All Multis by selecting the Multi Collection• 

Import from Motif Edit Buffer

Imports the Multi currently in the Motif Edit Buffer (i.e. the currently selected Multi on the Motif) to the Multi
currently selected within the active Child Window.

Note if you have more than one Multi selected then this operation is not available.

Export to Motif Edit Buffer

Exports the Multi currently selected within the active Child Window to the Motif Edit Buffer.

Note if you have more than one Multi selected then this operation is not available.

Multi Part Editing Features

motif.factory supports the following editing operations upon the  Multi Part Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Multi Part Collection to activate the  Multi Part Collection's Context Sensitive Menu.

Note: You can copy a Multi Part Collection to a Performance Part Collection. The first four parts in each
Multi are copied to the parts in the corresponding Performance.

Note: If you copy an ES Keyboard Mixing template that contains Mixing Voices to an ES Rack keyboard file
then the Mixing Voices are converted and copied to User Voices

motif.factory supports the following editing operations upon the Multi Part Objects within the Tree View of
a Child Window:

Copy/Move• 
Set Voice• 
Initialise• 
Insert• 
Delete• 
Set/Clear Layer Switch• 
Set/Clear Insert Switch• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Multi Part or selection of Multi Parts to activate the  Multi Part 's Context Sensitive Menu.

Note: You can copy a Multi Part to a Performance Part. 

Set Voice

A User Voice from the same file can be dragged onto a Multi Part to set the Voice used by the Multi Part.

If the Multi Part is actually a Mix Track under a Pattern or Song, then a Mixing Voice or Wave can be drag
copied onto the Mix Track.

Preset Voices from the Motif Synthesizer Window can be dragged onto Multi Parts as well.

Please note, the drag operation for this is COPY only. You cannot MOVE a Voice onto a Multi Part.
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Set/Clear Layer Switch

The Set/Clear Layer Switch options can be found on the Multi Part 's Context Sensitive Menu.

Using the available options you can:

Set the Layer Switch for the Part, as long as the maximum number of allowed Layer Switches is not
exceeded

• 

Clear the Layer Switch for the Part• 

Note: this command is not available if more than one Multi Part is selected.

Set Clear Insert Switch

The Set/Clear Layer Switch options can be found on the Multi Part 's Context Sensitive Menu.

Using the available options you can:

Set the Insert Switch for the Part, as long as the maximum number of allowed Insert Switches is not
exceeded

• 

Clear the Insert Switch for the Part• 

Note: this command is not available if more than one Multi Part is selected.

Multi Plugin Part Editing Features

motif.factory supports the following editing operations upon the Multi Plugin Part Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Multi Plugin Part Collection to activate the  Multi Part Collection's Context Sensitive Menu.

Note: You can copy a Multi Plugin Part Collection to a Performance Plugin Part Collection.

motif.factory supports the following editing operations upon the Multi Plugin Part Objects within the Tree
View of a Child Window:

Copy/Move• 
Set Plugin Voice• 
Initialise• 
Insert• 
Delete• 
Set/Clear Insert Switch• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Multi Plugin Part or selection of Multi Plugin Parts to activate the  Multi Plugin Part 's Context Sensitive
Menu.

Note: You can copy a Multi Plugin Part to a Performance Plugin Part.

Set Plugin Voice

A User Plugin Voice from the same file can be dragged onto a Multi Plugin Part to set the Plugin Voice used
by the Multi Plugin Part.

Please note, the drag operation for this is COPY only. You cannot MOVE a Voice onto a Multi Part.

Set Clear Insert Switch

The Set/Clear Layer Switch options can be found on the Multi Plugin Part 's Context Sensitive Menu.

Using the available options you can:

Set the Insert Switch for the Part, as long as the maximum number of allowed Insert Switches is not
exceeded

• 

Clear the Insert Switch for the Part• 
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Note: this command is not available if more than one Multi Plugin Part is selected.

Multi Effects Editing Features

motif.factory supports the following editing operations upon the Multi Effects Units Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Multi Effects Units Collection to activate the Multi Effects Units Collection's Context Sensitive Menu.

A Multi Effects Collection can also be moved/copied via drag and drop to Voice, Drum Voice, Plugin Voices,
Performances and the System Master Effects. If a Multi Effects Collection is copied to a Voice then the child
Reverb and Chorus Effects units are copied, and the Master Effect is copied/moved to the first Insert Effect.

motif.factory supports the following editing operations upon the individual Multi Effects Objects (Reverb,
Chorus, Master EQ and Master effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Multi
Effect or selection of Multi Effects to activate the Multi Effects's Context Sensitive Menu.

Multi Effects can also be copied/moved via drag and drop to the corresponding effect type in Voices, Drum
Voices, Plugin Voices, Performances and the System Master Effects. A Multi Master Effect can be copied to a
Voice, Drum Voice or Plugin Voice Insert Effect.

Motif ES Keyboard Multi Insert Effect Units are also supported.

Multi Arpeggiator Editing Features

motif.factory supports the following editing operations upon the Multi Arpeggiator Object shown within
the Tree View of a Child Window:

Copy/Move• 
Set Arpeggio• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Multi Arpeggiator to activate the  Multi Arpeggiator's Context Sensitive Menu.

You can Copy/Move  Multi Arpeggiators to/from Voice Arpeggiators, Drum Voice Arpeggiators, Plugin
Voice Arpeggiators and Performance Arpeggiators as well as Multi Arpeggiators.

A Motif Arpeggiator Unit as shown in the Tree View shows the default arpeggio that plays when the Multi is
first selected, and the five selectable arpeggios are shown as Child Objects. The following operations can be
carried out on the five arpeggios

Copy/Move• 
Set Arpeggio• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

You can also drag copy one of the five arpeggios onto the Arpeggio unit to set the default arpeggio.Please
note, the drag operation for this is COPY only. 

Set Arpeggio

Preset Arpeggios from the Motif Synthesizer Window can be dragged onto a Multi's Arpeggiator.
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You can also drag copy a User Arpeggio in a W7A file onto a Multi's Arpeggiator as well (assuming the Multi
is in the same W7A file).

Please note, the drag operation for this is COPY only. You cannot MOVE an Arpeggio onto an Arpeggiator.

Multi AD Part Editing Features

Note: AD Parts are not supported by the Motif Rack ES.

motif.factory supports the following editing operations upon the  Multi AD Part Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Multi AD Part Collection to activate the  Multi AD Part Collection's Context Sensitive Menu.

Note: You can copy a Multi AD Part Collection to a Performance AD Part Collection.

motif.factory supports the following editing operations upon the Multi AD Part Objects within the Tree View of
a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Multi AD Part or selection of Multi AD Parts to activate the  Multi AD Part 's Context Sensitive Menu.

Note: You can copy a Multi AD Part to a Performance AD Part.
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Master Editing Features

motif.factory supports the following editing operations upon the Master Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Master Collection Object in a file is only shown within a Tree View and is called User Masters.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Master Collection to activate the Master Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Master Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Set Voice/Performance/Song/Pattern• 
Initialise• 
Rename• 
Insert• 
Delete• 
Import from Motif Memory• 
Export to Motif Memory (only available if motif.factory is registered and MIDI support is enabled) • 
Import from Motif Edit Buffer• 
Export to Motif Edit Buffer (only if available motif.factory is registered and MIDI support is enabled)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy and Set (which you do via "Drag and Drop"), right click over
a Master or selection of Master to activate the Master's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a
Master:

Master Zones• 

Import from Motif Memory

Imports Masters from the Motif Memory locations into the currently selected Child Window.

You can import:

A Single Master• 
A Selection of Masters• 
All Masters by selecting the Master Collection• 

Export to Motif Memory

Exports Masters from the currently selected Child Window to the Motif Memory locations.

You can export:

A Single Master• 
A Selection of Masters• 
All Masters by selecting the Master Collection• 

Import from Motif Edit Buffer

Imports the Master currently in the Motif Edit Buffer (i.e. the currently selected Master on the Motif) to the
Master currently selected within the active Child Window.

Note if you have more than one Master selected then this operation is not available.
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Export to Motif Edit Buffer

Exports the Master currently selected within the active Child Window to the Motif Edit Buffer.

Note if you have more than one Master selected then this operation is not available.

Set Voice/Performance/Song/Pattern

A Voice, Performance, Song or Pattern from the same file can be dragged onto a Master to set the Object
referenced by the Master .

Preset Voices from the Motif Synthesizer Window can be dragged onto Masters as well.

Please note, the drag operation for this is COPY only. You cannot MOVE an Object onto a Master.

Master Zone Editing Features

motif.factory supports the following editing operations upon the Master Zone Objects within the Tree View of
a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy (which you do via "Drag and Drop"), right click over a Master
Zone or selection of Master Zones to activate the Master Zone 's Context Sensitive Menu.
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Arpeggio Editing Features

motif.factory supports the following editing operations upon the Arpeggio Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Save As W7G File (W7A files only)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Arpeggio Collection Object in a file is only shown within a Tree View and is called User Arpeggios.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Arpeggio Collection to activate the Arpeggio Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Arpeggio Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Arpeggio or selection of Arpeggio to activate the Arpeggio's Context Sensitive Menu.

Note: If an Arpeggio is colored red, then it is unused and it will not be saved to a file.
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Pattern Editing Features

motif.factory supports the following editing operations upon the Pattern Collection shown within the Tree
View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Save As W7P File (W7A files only)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Pattern Collection Object in a file is only shown within a Tree View and is called User Patterns.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Pattern Collection to activate the Pattern Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Pattern Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Pattern or selection of Pattern to activate the Pattern's Context Sensitive Menu.

The Pattern's Mix can also be edited.

Note: If a Pattern is colored red, then it is unused and it will not be saved to a file.
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Song Editing Features

motif.factory supports the following editing operations upon the Song Collection shown within the Tree View
of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Save As W7S File (W7A files only)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Song Collection Object in a file is only shown within a Tree View and is called User Songs.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Song Collection to activate the Song Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Song Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Song
or selection of Song to activate the Song's Context Sensitive Menu.

The Song's Mix can also be edited.

Note: If a Song is colored red, then it is unused and it will not be saved to a file.
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Song Chain Editing Features

motif.factory supports the following editing operations upon the  Song Chain Collection shown within the 
Tree View of a  Child Window:

Copy/Move• 
Initialise• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Song Chain Collection Object in a file is only shown within a  Tree View and is called User Song
Chains.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Song Chain Collection to activate the Song Chain Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Song Chain Objects within the  Tree View of
a  Child Window:

Copy/Move• 
Initialise• 
Set song• 
Insert• 
Delete• 
Skip• 
Stop• 
End• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Song
Chain or selection of Song Chain to activate the Song Chain's Context Sensitive Menu.

Set Song

A User Song from the same file can be dragged onto a Song Chain to set the Voice used by the Song
Chain.

Please note, the drag operation for this is COPY only. You cannot MOVE a Song onto a Song Chain.

Song Chain Commands

A song chain command of Skip, Stop, or End can be set via the Song Chain's Context sensitive Menu.

 Program Features 80



Mixing Voice Editing Features

motif.factory supports the following editing operations upon the Mixing Voice Collection shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Sort by Category• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The Mixing Voice Collection Object in a file is only shown within a Tree View and is called User Mixing
Voices.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Mixing Voice Collection to activate the Mixing Voice Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Mixing Voice Objects within the Tree View
or Table View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Mixing Voice or selection of Mixing Voices to activate the Mixing Voice's Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the following Objects that make up a Mixing
Voice :

Mixing Voice Elements• 
Mixing Voice Controllers• 
Mixing Voice Effects• 
Mixing Voice Arpeggiator Unit• 

Mixing Voice Element Editing Features

motif.factory supports the following editing operations upon the Mixing Voice Element Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
Mixing Voice Element Collection to activate the  Mixing Voice Element Collection's Context Sensitive
Menu.

motif.factory supports the following editing operations upon the Mixing Voice Element Objects within
the Tree View of a Child Window:

Copy/Move• 
Set Wave• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over a
Mixing Voice  Element or selection of Mixing Voices Elements to activate the  Mixing Voice Element's
Context Sensitive Menu.
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Set Wave

The Wave for an AWM Element can be set by drag copying a Preset Wave onto the Element.

In a W7A or W7V file you can also drag copy a User Wave onto the Element.

Please note, the drag operation for this is COPY only. E.g. you cannot MOVE a Preset Wave onto an
Element.

Mixing Voice Effects Editing Features

motif.factory supports the following editing operations upon the Mixing Voice Effects Units Collection
shown within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Mixing Voice Effects Units Collection to activate the Mixing Voice Effects Units Collection's Context
Sensitive Menu.

A Mixing Voice Effects Collection can also be moved/copied via drag and drop to Drum Mixing Voices,
Plugin Mixing Voices, Performances and Multis. If a Mixing Voice Effects Collection is copied to a
Performance or Multi  then only the child Reverb and Chorus Effects units are copied.

motif.factory supports the following editing operations upon the individual Mixing Voice Effects Objects
(Reverb, Chorus, INS1 and INS2 effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Mixing Voice Effect or selection of  Mixing Voice Effects to activate the Mixing Voice Effects's Context
Sensitive Menu.

Mixing Voice Effects can also be copied/moved via drag and drop to the corresponding effect type in Drum
Mixing Voices, Plugin Mixing Voices, Performances and Multis and the System Master Effects. A Mixing Voice
Insert Effect can be copied to a Performance, Multi or System Master Effect.

Mixing Voice Controller Editing Features

motif.factory supports the following editing operations upon the Mixing Voice Controllers Collection shown
within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Mixing Voice Controllers Collection to activate the Mixing Voice Controllers Collection's Context
Sensitive Menu.

motif.factory supports the following editing operations upon the Mixing Voice Controller Objects within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Mixing Voice Controller or selection of Mixing Voice Controllers to activate the Mixing Voice Controller's
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Context Sensitive Menu.

Mixing Voice Arpeggiator Editing Features

motif.factory supports the following editing operations upon the Voice Arpeggiator Object shown within
the Tree View of a Child Window:

Copy/Move• 
Set Arpeggio• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move, Copy and Set (which you do via "Drag and Drop"), right click over the 
Mixing Voice Arpeggiator to activate the  Mixing Voice Arpeggiator's Context Sensitive Menu.

You can Copy/Move  Mixing Voice Arpeggiators to/from Drum Mixing Voice Arpeggiators, Plugin Mixing
Voice Arpeggiators, Performance Arpeggiators and Multi Arpeggiators as well as  Mixing Voice
Arpeggiators.

A Motif Arpeggiator Unit as shown in the Tree View shows the default arpeggio that plays when the Mixing
Voice is first selected, and the five selectable arpeggios are shown as Child Objects. The following operations
can be carried out on the five arpeggios

Copy/Move• 
Set Arpeggio• 
Initialise• 
Insert• 
Delete• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

You can also drag copy one of the five arpeggios onto the Arpeggio unit to set the default arpeggio.Please
note, the drag operation for this is COPY only. 

Set Arpeggio

Preset Arpeggios from the Motif Synthesizer Window can be dragged onto a Mixing Voice's Arpeggiator.

You can also drag copy a User Arpeggio in a W7A file onto a Mixing Voice's Arpeggiator as well (assuming
the Mixing Voice is in the same W7A file).

Please note, the drag operation for this is COPY only. You cannot MOVE an Arpeggio onto an Arpeggiator.
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Wave Editing Features

motif.factory supports the following editing operations upon the Wave Collection shown within the Tree View
of a Child Window:

Copy/Move• 
Initialise• 
Sort by Name• 
Save As W7W File (W7A files only)• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The  Wave Collection Object in a file is only shown within a Tree View and is called User Waves.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Wave Collection to activate the Wave Collection's Context Sensitive Menu.

motif.factory supports the following editing operations upon the Wave Objects within the Tree View or Table
View of a Child Window:

Copy/Move• 
Initialise• 
Rename• 
Insert• 
Delete• 
List References• 
Add To Library• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a Wave
or selection of Wave to activate the Wave's Context Sensitive Menu.

Note: If a Wave is colored red, then it is unused and it will not be saved to a file.

A Wave can be drag copied onto a Voice Element (normal, drum or mixing), or a Mix Track
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System Configuration Editing Features

motif.factory supports the following editing operations upon the System Configuration Object shown within
the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

The System Settings Object in an file is only shown within a Tree View and is called System Configuration.

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the 
System Configuration Object to activate its Context Sensitive Menu.

Within the Tree View of a Child Window you can also directly edit the System Effects

System Configuration Master Effects Editing Features

motif.factory supports the following editing operations upon the System Master Effects Units Collection
shown within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over the
Master Effects Units Collection to activate the Master Effects Units Collection's Context Sensitive Menu.

A Master Effects Collection can also be moved/copied via drag and drop to Performances and Multis.

motif.factory supports the following editing operations upon the individual Master Effects Objects (Master EQ
and Master effects units) within the Tree View of a Child Window:

Copy/Move• 
Initialise• 
Cut to Clipboard• 
Copy to Clipboard• 
Paste from Clipboard• 

To access all features other than Move and Copy (which you do via "Drag and Drop"), right click over a
Master Effect or selection of Master Effects to activate the Multi Effects's Context Sensitive Menu.

Master Effects can also be copied/moved via drag and drop to the corresponding effect type in Performances
and the System Master Effects.
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Master Patch List

The Master Patch List Dialog is found on the Tools menu.

The Master Patch List Dialog provides a means for you to generate a single patch list from a list of files.
Currently only Cubase Patch Scripts can be generated, but future versions may support other sequencers.

The Master Patch List dialog is shown below:

This dialog has the following options:

File List The list of files to incorporate into a single patch list.

If you click on one of the lines then you can edit the file either by typing
or by using the [...] button to the right of the line to bring up a file selector
dialog.

Note, if you are editing a line, and you are finished, you need to select
another line, or press the RETURN key for the changes to be stored.

New Inserts a new line in the file list.
Delete Deletes the currently selected line in the file list. If no line is selected this

control is disabled.
Move Up Moves the currently selected line in the file list up one line. If no line is

selected or the selected line is the first in the list then this control is
disabled.

Move Down Moves the currently selected line in the file list down one line. If no line is
selected or the selected line is the last in the list then this control is
disabled.

Sort Sorts the lines into ascending alphabetical order
Cubase Exports the files identified in the file list to a Cubase format patch script

file, which is compatible with Cubase VST/SX/SL/SE.
Include Preset Data When this option is checked, the Motif Preset Voices are exported at the

start of the patch list.
OK Closes the dialog.
Generating The Cubase Master Patch List

When you generate a Cubase Patch Script, it is written to the directory specified by the Cubase Patch Script
Directory field in the Misc Preferences Tab of the Preferences Dialog. You can set this field up to export the
master patch list directly to the directory read by Cubase upon startup. This directory on my system is
C:\Documents and Settings\Derek\Application Data\Steinberg\Cubase SX
3\Scripts\Patchnames\inactive\yamaha where "C:" is the root drive that Cubase is installed on, "Derek" is
my Windows user name, aand "Cubase SX 3" is my version of Cubase. You will need to vary these
according to your system drive and of course your own user name and version of Cubase.

By default the Application Data folder is hidden in Windows Explorer, so you may not see this folder first of
all. If you cannot see the folder:
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In Windows Explorer select Folder Options from the Tools menu and click the View tab.1. 
Look down the Advanced Settings list and find the Hidden Files and Folders option.2. 
Select the Show Hidden Files and Folders sub option.3. 
Select OK to close the dialog.4. 

Cubase only looks for and reads patch scripts when it starts up, so if you're in Cubase after generating the
patch script then exit Cubase and start it up again.

Configuring Cubase to Use the Master Patch List

The patch scipts generated by motif.factory should be compatible with Cubase VST/SX/SL/SE. The
instructions given below are for Cubase SX, which is the version I use. Consult your Cubase documentation
for how to install patch scripts if you have a different version.

Within Cubase:

Select Midi Device Manager from the Devices Menu.1. 
Click on the Install Device button.2. 
Click on the Motif - Master Patch List option (this is the motif.factory generated file). At the bottom of
this dialog, select your output MIDI port that the Motif is connected to. You can now close this dialog.
If you cannot see the Motif - Master Patch List then you have not placed it in the right folder.

3. 

This installs the patch list within Cubase and allows you to use it elsewhere within the application.

In the main Cubase screen, select or create a MIDI track that you wish to be used with the Motif. In the
Inspector window (the panel to the left of the main window) click on the out control and you should now be
able to see and select the Motif - Master Patch List option in amongst the MIDI ports. Also ensure the MIDI
channel number for the track matches the Motif channel number.

Now when you click in the Programs control, just below the out control, you'll see a drop down list containing
all of the Motif Voices names generated by motif.factory.

You can now scroll through the lists to find a Voice, an you can also type in filter text to quickly look for a
Voice.

Library Statistics

The Library Statistics menu option is found on the Tools menu.

This feature is only available if your copy of motif.factory is registered.

The Library Statistics Dialog provides a means for you to see a summary of the contents of the Library.

Batch Import To Library

The Batch Import To Library Wizard is found on the Tools menu.

This feature is only available if your copy of motif.factory is registered.

The Batch Import To Library Wizard provides a means for you to import several Motif files to the library in one
go.

The Batch Import To Library Wizard has two pages to navigate through:

The Select Source Directory Page• 
The Select Destination Directory Page• 
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Select Source Directory Page

The Select Source Directory Page is shown below

This page has the following options

Source Directory You can type the name of the source directory in this control.

Or if you click the [...] button to the right of the line, this will bring up a file
selector dialog.

Scan Subdirectories If this control is checked, then the Batch Converter will also include any
subdirectories that it finds within the source directory when looking for
files to convert.

If this control is not checked then any subdirectories in the source
directory will be ignored.

Ignore File Errors If this control is not checked then any errors detected during file loading
will halt the conversion process.

If this control is checked then these errors are ignored, but are logged if
logging is enabled.

Select Destination Directory Page

The Select Destination Directory Page is shown below

This page has the following options

When an Object being added is
already in the Library

Provides the action to do if an Object is added to the Library and there is
already an identical Object in the library. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 
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When an Object being added
already has the same name as an
Object in the Library

Provides the action to do if an Object is added to the Library and there is
already an Object in the library with the same name. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 

Create Log File If this control is checked then a log file is created in the destination
directory.

This log file is called "Log File.txt", and can be opened with any text
editor

Using the Batch Importer

Using the importer is quite simple.

Importing a Motif file takes about 20 seconds, so if you have a lot of files to import, be prepared to leave the
importer running for a while! The import of a file will be slower if you have a large library as motif.factory needs
to check to duplicate data, so the larger the library the more data the batch importer has to search.

The importer is a simple "Wizard" and you can step through the choice pages using the Prev and Next
buttons, or exit the Wizard using the Cancel Button

Select the source and destination directory options and once that is done click on the Finish button to start
the Batch Import Wizard.

The Wizard will not allow you to select a directory that doesn't exist.

Once the Wizard starts the progress of importing files is shown in the information pane.

There is a progress bar that shows the progress for all the files that the importer has detected, and a progress
bar for the objects in the file currently being imported.

The Wizard also shows how many file errors have been encountered (assuming you have set the options to
ignore File errors).

You can cancel the import at any time by pressing the Cancel button, but you may need to wait for
motif.factory to finish the current file import before the batch conversion is cancelled.

Once completed, a summary results page is shown that summarises the import.
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The Wizard can be dismissed by clicking the Close button.

You can check the results of the import by opening the Log File.txt file (assuming you left logging enabled).

The log file is a simple text file that lists each source file and whether any errors were detected.

All errors are preceded by ** (two stars), so you can use your text editor's find/search facilities to look for ** to
quickly find any errors.
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Preferences
The motif.factory preferences are accessed via the View menu Preferences ... option.

Selecting this option opens a Tabbed dialog with the following tabs which group related parameters:

Device Type Preferences• 
Voice Preferences• 
Performance Preferences• 
Multi Preferences• 
Master Preferences• 
Song Chain Preferences• 
System Preferences• 
MIDI Preferences• 
Default View Preferences• 
Library Preferences• 
Miscellaneous Preferences• 

To view and modify a set of parameters, click on the relevant tab.

Note: The options to update Objects following an Object move within the same file (e.g. Update
Voices/Elements after Wave Move) also apply when Objects that can be referenced are inserted, deleted
and sorted.

Note: The options to copy referenced Objects with "parent" Objects (e.g. moving Voices with Performances)
work by:

Checking the destination file to see if the referenced Object exists• 
If it does then the parent Object is updated after being moved to point to the existing Object in the
destination file

• 

If not then motif.factory checks to see if a blank or empty child Object is present in the destination file
(e.g. in the case of moving a Voice, a blank "INIT VOICE" is looked for)

• 

If a blank Object is found then the child Object is moved or copied and the parent Object is updated
after being moved to point to the new Object in the destination file

• 

If no blank Object is found the motif.factory gives up. Note this may result in a Partial edit (e.g. it may
have only been possible to copy a subset of Objects due to the amount of free Objects in the
destination file)

• 

The child Objects are only ever copied irrespective of whether the parent Object is being moved or
copied. This is to avoid the problem that would occur when a child Object is moved (say a Voice with
Performance 1), where the source child Object (which would have been initialised after the move) is
also referenced by other Parent Objects (e.g. another Performance)

• 

All the above options are sensitive to what is being dragged. For example a Performance Part, Performance
Part Branch, Performance or Performance Branch can be dragged and the necessary Objects will be copied
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Device Type Preferences
The Device Type Preferences tab is shown below:

This tab has the following options:

Motif Device Type Allows you to select the type of Motif you have from the following
options:

Motif ES6• 
Motif ES7• 
Motif ES8• 
Motif ES Rack• 

This parameter is used by motif.factory to:

Check for the expected device type during startup• 
When testing the MIDI interface.• 
When creating SYSEX files to, for example, create the
correct number of voices.

• 
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Voice Preferences
The Voice Preferences tab is shown below:

This tab has the following options:

Update Voices After Wave Move If you move a Wave within a file then the Voices and their Elements are
updated to ensure that the correct references to User Waves are
maintained.

Update Voices After Arpeggio
Move

If you move a User Arpeggio within a file then the Waves are updated to
ensure that the correct references to User Arpeggios are maintained.

Copy User Waves With Voice If you move or copy a Voice  from a file to another file, then any User
Waves referenced by the Voice and its Elements are also copied to the
destination file if the Waves are not already present in the destination
file.

Copy User Arpeggios With Voice If you move or copy a Voice from a file to another file, then any User
Arpeggios referenced by the Voice are also copied to the destination file
if the User Arpeggios are not already present in the destination file.

Include Voices In Bulk Transfer When this option is checked, the Voices are included in MIDI bulk
transfers.

Include Drum Voices In Bulk
Transfer

When this option is checked, the Drum Voices are included in MIDI bulk
transfers. You may wish to uncheck this option if you don't use Drum
Voices.

Include Plugin Voices In Bulk
Transfer

When this option is checked, the Plugin Voices are included in MIDI bulk
transfers. You may wish to uncheck this option if you don't use Plugin
Voices.
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Performance Preferences
The Performance Preferences tab is shown below:

This tab has the following options:

Update Performances After Voice
Move

If you move a Voice within a file then the Performances and their Parts
are updated to ensure that the correct references to User Voices are
maintained.

Update Performances After Drum
Voice Move

If you move a Drum Voice within a file then the Performances and their
Parts are updated to ensure that the correct references to User Drum
Voices are maintained.

Update Performances After
Plugin Voice Move

If you move a Plugin Voice within a file then the Performances and their
Plugin Parts are updated to ensure that the correct references to User
Plugin Voices are maintained.

Update Performances After
Arpeggio Move

If you move a User Arpeggio within a file then the Performances are
updated to ensure that the correct references to User Arpeggios are
maintained.

Copy User Voices With
Performance

If you move or copy a Performance from a file to another file, then any
User Voices referenced by the Performance and its Parts are also
copied to the destination file if the Voices are not already present in the
destination file.

Copy User Drum Voices With
Performance

If you move or copy a Performance from a file to another file, then any
User Drum Voices referenced by the Performance and its Parts are also
copied to the destination file if the Drum Voices are not already present
in the destination file.

Copy User Plugin Voices With
Performance

If you move or copy a Performance from a file to another file, then any
User Plugin Voices referenced by the Performance and its Parts are also
copied to the destination file if the Plugin Voices are not already present
in the destination file.

Copy User Arpeggios With
Performance

If you move or copy a Performance from a file to another file, then any
User Arpeggios referenced by the Performance are also copied to the
destination file if the User Arpeggios are not already present in the
destination file.
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Start Voice Copy With
Performances In Bank U2

If this option is selected then when Voices are copied to a new file along
with Performances the Voices are copied into bank U2 only. Hint: this
option was requested by a user who wished to have Voice Bank U1 free
for his Voices not used by Performances with Bank U2 used for storing
Voices that are used by Performances.
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Multi Preferences
The Multi Preferences tab is shown below:

This tab has the following options:

Update Multis After Voice Move If you move a Voice within a file then the Multis and their Parts are
updated to ensure that the correct references to User Voices are
maintained.

Update Multis After Drum Voice
Move

If you move a Drum Voice within a file then the Multis and their Parts are
updated to ensure that the correct references to User Drum Voices are
maintained.

Update Multis After Plugin Voice
Move

If you move a Plugin Voice within a file then the Multis and their Plugin
Parts are updated to ensure that the correct references to User Plugin
Voices are maintained.

Update Multis After Arpeggio
Move

If you move a User Arpeggio within a file then the Multis are updated to
ensure that the correct references to User Arpeggios are maintained.

Copy User Voices With Multi If you move or copy a Multi from a file to another file, then any User
Voices referenced by the Multi and its Parts are also copied to the
destination file if the Voices are not already present in the destination
file.

Copy User Drum Voices With
Multi

If you move or copy a Multi from a file to another file, then any User
Drum Voices referenced by the Multi and its Parts are also copied to the
destination file if the Drum Voices are not already present in the
destination file.

Copy User Plugin Voices With
Multi

If you move or copy a Multi from a file to another file, then any User
Plugin Voices referenced by the Multi and its Parts are also copied to the
destination file if the Plugin Voices are not already present in the
destination file.

Copy User Arpeggios With Multi If you move or copy a Multi from a file to another file, then any User
Arpeggios referenced by the Multi are also copied to the destination file if
the User Arpeggios are not already present in the destination file.
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Start Voice Copy With Multis In
Bank U2

If this option is selected then when Voices are copied to a new file along
with Multis the Voices are copied into bank U2 only. Hint: this option was
requested by a user who wished to have Voice Bank U1 free for his
Voices not used by Multis with Bank U2 used for storing Voices that are
used by Multis.

 Preferences 97



Master Preferences
The Master Preferences tab is shown below:

This tab has the following options:

Update Masters After Voice Move If you move a Voice within a file then the Masters are updated to ensure
that the correct references to User Voices are maintained.

Update Masters After Drum Voice
Move

If you move a Drum Voice within a file then the Masters are updated to
ensure that the correct references to User Drum Voices are maintained.

Update Masters After Plugin
Voice Move

If you move a Plugin Voice within a file then the Masters are updated to
ensure that the correct references to User Plugin Voices are maintained.

Update Masters After
Performance Move

If you move a User Performance within a file then the Masters are
updated to ensure that the correct references to User Performances are
maintained.

Update Masters After Song Move If you move a User Song within a file then the Masters are updated to
ensure that the correct references to User Songs are maintained.

Update Masters After Pattern
Move

If you move a User Pattern within a file then the Masters are updated to
ensure that the correct references to User Patterns are maintained.

Copy User Voices With Master If you move or copy a Master from a file to another file, then any User
Voices referenced by the Master are also copied to the destination file if
the Voices are not already present in the destination file.

Copy User Drum Voices With
Master

If you move or copy a Master from a file to another file, then any User
Drum Voices referenced by the Master are also copied to the destination
file if the Drum Voices are not already present in the destination file.

Copy User Plugin Voices With
Master

If you move or copy a Master from a file to another file, then any User
Plugin Voices referenced by the Master are also copied to the
destination file if the Plugin Voices are not already present in the
destination file.
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Copy User Performances With
Master

If you move or copy a Master from a file to another file, then any User
Performances referenced by the Master are also copied to the
destination file if the User Performances are not already present in the
destination file.

Copy User Songs With Master If you move or copy a Master from a file to another file, then any User
Songs referenced by the Master are also copied to the destination file if
the User Songs are not already present in the destination file.

Copy User Patterns With Master If you move or copy a Master from a file to another file, then any User
Patterns referenced by the Master are also copied to the destination file
if the User Patterns are not already present in the destination file.

Start Voice Copy With Masters In
Bank U2

If this option is selected then when Voices are copied to a new file along
with Masters the Voices are copied into bank U2 only. Hint: this option
was requested by a user who wished to have Voice Bank U1 free for his
Voices not used by Masters, with Bank U2 used for storing Voices that
are used by Masters.

Include Masters In Bulk Transfer When this option is checked, the Masters are included in MIDI bulk
transfers. You may wish to uncheck this option if you don't use Masters.
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Song Chain Preferences
The Song Chain Preferences tab is shown below:

This tab has the following options:

Update Song Chains After Song
Move

If you move a Song within a file then the Song Chains are updated to
ensure that the correct references to User Songs are maintained.

Copy User Songs With Song
Chain

If you move or copy a Song Chain from a file to another file, then any
User Songs referenced by the Song Chain are also copied to the
destination file if the Songs are not already present in the destination file.
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System Preferences
The System Preferences tab is shown below:

This tab has the following options:

Include System In
Bulk Transfer

When this option is checked, the System settings are included in bulk transfers. You
may wish to uncheck this option if you don't wish to transfer the system settings.
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MIDI Preferences
The MIDI Preferences tab is shown below:

This tab has the following options:

Keyboard Input MIDI
Port

Sets the port used for accepting MIDI data from a keyboard and routing it to the
output MIDI port using the MIDI Router Dialog.

Keyboard Input MIDI
Channel

Sets the channel to be used for transmitting MIDI data using the MIDI Router
Dialog. The first option Use Source Channel in the drop down list, means that the
MIDI channel from the source device is not altered.

Motif Input MIDI Port Sets the port used for MIDI input from Motif from the available ports.
Motif Output MIDI Port Sets the port used for MIDI output to the Motif from the available ports.
SYSEX Device Number Sets the SYSEX device number used for SYSEX transfers. This must match the 

Device No value set in the Motif's Utility Mode MIDI tab. If the Motif Device No is
set to all then it will receive all Motif SYSEX messages irrespective of the device
number in the message.

Timeout Delay Sets the time that motif.factory waits for a response from the Motif before timing out
and reporting an error. The value is specificied in milliseconds.

Transmit Buffer Size Sets the size of the transmit buffer used for sending data to the Motif. Some MIDI
interfaces don't like data coming in big chunks and you may need to set this to get
a reliable transfer of data. The value is specificied in milliseconds.

Transmit Delay
Between Buffers

This sets the delay that motif.factory waits for between sending buffer sized data
packets. The value is specificied in milliseconds.

Transmit Delay
Between Objects

This sets the delay that motif.factory waits for after sending a complete object. The
value is specificied in milliseconds.

Automatically Update
Motif after Synth
Window Edit

When this option is checked, if the Motif Synthesizer Window is edited then the
edited data will be automatically sent to the Motif.

Read Motif MIDI Data
On motif.factory
Startup

When this option is checked the data is read from the Motif during the motif.factory
startup phase.
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Test Midi Settings Tests to see if MIDI comms is working using the specified values. The test:

Send a Device ID Request message on the specified MIDI output port1. 
Waits for a response on the specified MIDI input port. If the response times
out an error message is displayed

2. 

Checks to see if the reported Device ID matches the setting specified in
the Device Type Preferences tab. If the device type does not match then
an error message is displayed

3. 
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Default View Preferences
The Default View Preferences tab is shown below:

Default View Defines the type of view that is applied to a Child Window when it is first
opened.

The following options are available:

No Split• 
Horizontal Split• 
Vertical Split• 

Pane/Left Pane/Top Pane Defines the type of view shown in the single pane of an unsplit view, the
left pane of a horizontally split view or the top pane of a vertically split
view.

The following options are available:

Tree View• 
Table View• 

Right Pane/Bottom Pane This control is only visible if the Default View option is set to either
Horizontal Split or Vertical Split.

Defines the type of view shown in the right pane of a horizontally split
view or the bottom pane of a vertically split view.

The following options are available:

Tree View• 
Table View• 

View Tool Bar Controls if the toolbar is visible at startup.
View Status Bar Controls if the status bar is visible at startup.
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View Backdrop In Child Window This option controls if the image backdrop is displayed in Child Windows.

You may wish to turn off this option if you find the scrolling of the Child
Window is slow on your machine.
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Library Preferences
The Library Preferences tab is shown below:

This tab has the following options:

When an Object being added is
already in the Library

Provides the action to do if an Object is added to the Library and there is
already an identical Object in the library. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 
Ask What To Do• 

When an Object being added
already has the same name as an
Object in the Library

Provides the action to do if an Object is added to the Library and there is
already an Object in the library with the same name. The choices are:

Add to Library (with a new name)• 
Do not add to Library• 
Overwrite Object in the Library• 
Ask What To Do• 

Copy Referenced Objects to
Library

If this Option is checked, then any Objects being referenced by an
Object being added to the Library are also added to the Library.

Prompt for Author of File When
Adding a File

If this Option is checked then motif.factory will ask for the Author of the
file if one has not already been entered.

Default Filter for Rating Column Sets the default filter type for the Rating column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 
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Default Filter for the Comment
Column

Sets the default filter type for the Comment column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

Default Filter for the Author
Column

Sets the default filter type for the Author column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 

Default Filter for the Source
Column

Sets the default filter type for the Source column. The choices are:

Regular Expression (can contain Perl Regular Expressions)• 
Match Value (can only be selected using an existing value)• 
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Miscellaneous Preferences
The Miscellaneous Preferences tab is shown below:

This tab has the following options:

Startup Directory Allows the startup directory to be specified. Note: no validation is
performed on this pathname, so please ensure it is valid. I may add
validation later.

The [...] button to the right of the field brings up a dialog that allows you
to select the directory instead of typing it in.

Cubase Patch Script Directory Specifies the directory where Cubase patch scripts are written. Note: no
validation is performed on this pathname, so please ensure it is valid. I
may add validation later.

The [...] button to the right of the field brings up a dialog that allows you
to select the directory instead of typing it in.

Sample Load Options Determines what motif.factory does with Sample (W8n) files when load
W7n files. You can select the behaviour from the following choices:

No  - Sample files are not loaded• 
Yes - Sample files are automatically loaded• 
Confirm - motif.factory asks you if you wish to load a sample file• 

Load Last File On Startup Controls if the last file opened in the previous session is automatically
loaded when motif.factory is next invoked.

Check For Duplicates When
Moving or Copying Objects

If you move or copy an Object to a destination file and the Object already
exists then a warning is presented giving you the option to continue or
cancel the operation.

Warn if Destination Object is
Referenced When Moving or
Copying Objects

If you move or copy an Object and it is overwriting an Object that is
being referenced, or you are deleting a referenced Object, then a
warning is presented giving you the option to continue or cancel the
operation.
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Online Help
motif.factory provides a full online version of the motif.factory manual.

If you select Help ... from the Help Menu or the   button on the Tool Bar, the Help Window is opened.

The Help Window works just like a web browser window, so its operation should be quite familiar to you.

The left pane of the Help Window shows a tabbed navigation pane to allow you to quickly navigate to a topic,
whilst the right hand pane shows the help topic.

The navigation pane can show three different views, depending on which tab you select:

    Displays the Table of Contents Navigation Pane, providing a structured list of motif.factory
topics

• 

    Displays the Index Navigation Pane, providing an indexed list of motif.factory topics• 
    Displays the Search Navigation Pane, allowing you to search the help topics for keywords• 

The Help Window has the following Tool Bar buttons:

    Navigates backwards to the last page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

    Navigates forwards to the next page in the access sequence. If you press and hold the mouse
button over this button, you will get a list of accessed pages

• 

    Selects the home page• 
    Refreshes the current page• 
    Prints the current page• 
    Displays the print settings dialog• 

Context Sensitive Help
You can access context sensitive help by:

pressing the your Computer Platform's Help Key ( F1 on the PC platform), which will load the help
page associated with the Component within the motif.factory Window that currently has Focus (is
responding to the keyboard and mouse).

• 

pressing the  button on the Tool Bar and the clicking over the item of interest• 
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You can press the Help Key in any motif.factory Dialog to access the relevant help page for the Dialog.
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Tips and Tricks
The motif.factory tips and tricks dialog is shown below:

This dialog has the following controls:

Close Closes the Tips and Tricks Dialog
Next Tip Selects the next tip in sequence
Show Tips at
Startup

If checked then when motif.factory starts up, the Tips and Tricks Dialog is automatically
opened

List of Tips and Tricks
Just in case you want the tips and tricks shown by the dialog as one single list, here they are.

Double Clicking a voice

If you double click a voice in a file or the library, it will be sent to the synth's edit buffer. If you triple click
instead, the MIDI Router dialog will be opened after the voice is sent to the synth's edit buffer.

Library Support

motif.factory provides a Library facility that allows you to store all your data in one place, and use filtering and
sorting facilities to locate the data that you want.

(NOTE: Library features are available only to registered users).

MIDI Support

motif.factory supports the transfer of Voices and Performances between motif.factory and the Motif via MIDI.

(NOTE: MIDI export features are available only to registered users).

Context Sensitive Help

If you press the Help Key ( F1 on a PC) then you can get context sensitive help, including within Dialogs.

Keyboard Shortcuts

motif.factory supports numerous keyboard shortcuts as an alternative to using the mouse.

Take a look in the online help or the motif.factory manual for details of the supported keyboard shortcuts

S90 ES Voice Editor Files

motif.factory can load S90 ES Voice Editor (S7E) files. A Motif ES Voice Editor (W7E) file is created when you
load an S7E file.

Master Patch List

The Master Patch List dialog under the Tools menu allows you to define a list of files that are exported,
along with preset voice definitions, as a master patch list for use in supported sequencers to select patchs.
Currently only Cubase VST/SX/SE/SL patch lists are supported.
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Copying Arpeggiator Units

Within motif.factory you can copy, for example, a Voice Arpeggiator Unit to a Drum Voice, Plugin Voice,
Performance or Multi Arpeggiator unit and vice versa

Copying Performances and Multis

Within motif.factory you can copy Performances to Multis and Vice Versa. You can do this for
Performance/Multi Part Collections and Performance/Multi Parts as well.

Object Colouring

If an Object such as a Voice is coloured blue, then it is being referenced by another Object.

If you right click over a blue Object you'll find a "List References" context menu, which will show you the
Objects that reference this one.

An Object is coloured red if it is "empty" and will not be saved in a file.

Copying Effects Units

Within motif.factory you can copy, for example, a Voice Effects Unit to a Drum Voice, Plugin Voice,
Performance or Multi Effects Unit unit and vice versa

Load Sample Files

motif.factory can be set to automatically load W8n sample data when it loads data files. For example if you
load foo.W7A, motif.factory can be set to load foo.W8A if it exists. You can set the desired mode of operation
in the Preferences Dialog.

If sample data is loaded, it is loaded into the corresponding Wave, and is part of the Wave (and thus can be
copied and moved) until the data is saved.

MIDI Router

Press the F12 key and you get a "MIDI Router" popping up which, whilst active, will route MIDI data form the
Keyboard MIDI Port through to the Motif Output MIDI Port. This allows you to have the USB connection
selected on the Motif, whilst allow you to play data coming from a standard MIDI interface

Find/Find Next Category Tool Bar Buttons

If you hold the SHIFT key down whilst pressing the Find or Find Next tool bar button the operations
performed change from:

Find to Find Category• 
Find Next to Find Next Category• 

Table Sorting

You can sort Tables by clicking in the Table Column headers.

For example, if you click in the Category Column then the Table will be sorted by Category

You can only DRAG COPY Certain Objects

If you are trying to perform a drag operation on certain data types and are wondering why motif.factory is not
allowing you to perform the drag, try holding down the CTRL key during the drag to see if this is then allowed.
Holding down the CTRL key turns the operation from a Drag Move operation to a Drag Copy operation.

Sometimes during a drag operation, the only sensible operaton that can be undertaken is a copy operation,
for example:

Dragging preset synth data• 

In these circumstances a move operation does not make sense so it is not allowed.

Copying/Moving Objects to a Different File

When you copy an Object to a different file then any Objects it references can also be copied at the same
time.

For example of you move a Performance to a new File, then the referenced Voices are also copied:
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I think you'll agree this is a cool feature!

This feature can be selectively turned off for different Object types if required within the Preferences Dialog.
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Exporting Patch Lists

You can export Patch lists from files for use within either Cubase, Protools or Sonar.

You can also export file information to HTML, XML or SpreadSheetML formats.

The relevant options can be found on the File Menu under the Export option.
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About motif.factory
The about dialog is shown when the About ... option from the  Help Menu or the  button on the Tool Bar is
selected.

The dialog shows some basic information about the program including the version number and the License
status of motif.factory.

It also shows which Java Run Time Environment that motif.factory is running in.

It's also a chance to take a close look at the excellent Splash Graphic provided by Torus!
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Glossary
Term Definition
Child Window A window associated with an Motif data file that you have opened that is used to display the

contents of the file.

Several Child Windows can be open within the motif.factory Desktop.
Clipboard A temporary storage area used for transferring data within a Child Window or between

Child Windows.
Collection A group of similar and related Objects.

For example a Voice Collection stores the 256 Voice Objects that a file can contain
Context
Sensitive Help

The ability of the help system to tailor the help being displayed according to where the user
pressed the Help key.

Context
Sensitive Menu

The popup menu that is displayed in either the Tree View or Table View that provides a set
of commands specific to the currently selected Object

Desktop The area within the motif.factory window where Child Windows can be opened
Drag and Drop The name for the mechanism that allows a use to move data by dragging it with a mouse

and dropping it at a new location.
DRAG
MODIFIER

The keyboard key that is held down to turn a Drag and Drop move operation into a copy
operation.

On the PC platform, the DRAG MODIFIER key is the CTRL (control) key
JRE Java Run-time Environment. This provides the Java environment which motif.factory needs

in order to run.

Sun Microsystems provides the JRE for PC systems, and Apple provide their own JRE for
MacOS X

Library A repository where you can store all of your data.
MDI Multiple Document Inteface. The type of user interface used by motif.factory which allows

several Windows to be open within the main application window.
Menu Bar The area of the motif.factory Window that contains the set of menus used for accessing the

main functions provided by the application.
MIDI Musical Instrument Digital Interface. The primary means by which digital data is exchanged

in a serial form between synthesizers and computers.
MMJ A MacOS X specific library that provides the means by which external MIDI devices can be

accessed with the Java MIDI framework.
Motif Library
Window

A special instance of a Child Window that doesn't display data in a file, but which displays
the data stored in the Motif Library.

Motif
Synthesizer
Window

A special instance of a Child Window that doesn't display data in a file, but which displays:

Preset data within the Motif• 
User data imported from the Motif via MIDI• 

Object A piece of Motif data such as a Voice or Performance.
Preset Synth
Data

The lists of data within the Motif Synthesizer Window that lists the preset data available
within the Motif.

Reference The means by which the Motif associates an Object (such as a Voice) with another Object
(such as a Performance Part). The reference provides the link between the two, and in the
case of the Motif, the link is simply the number of the referenced Object.

Regular
Expression

A system by which certain character sequences are interpreted not as plain text but as
commands that can provide a tailored search for occurences of text

Status Bar The area of the motif.factory Window that is used to display status information upon the
currently selected Child Window. 

Table View A View which displays data in a file arranged in tablulated rows of data
Tool Bar The area of the motif.factory Window that contains a set of buttons to provide easy access

to commonly used commands
Tree View A View which displays data in a file arranged in a hierarchical tree structure.
View The means by which the data in a file is viewed.

A Child Window provides the view upon an Motif File that you have opened.

The view can be either a Tree View or a Table View.

You can have several views open upno the same data, for example when you have split a
Child Window.
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Workspace An arrange of the main motif.factory Window and Child Windows which can be saved for
subsequent recall.
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Keyboard Short Cuts
ex.factory provides many keyboard shortcuts for navigation and performing editing operations.

In general, navigating between components uses these keys:

Tab. Moves keyboard focus to the next component or to the first member of the next group of
components.

• 

Ctrl-Tab. Moves keyboard focus to the next component or to the first member of a group of
components when the current component accepts a tab (as in text fields, tables, and tabbed panes).

• 

Shift-Tab. Moves keyboard focus to the previous component or to the first component in the previous
group of components.

• 

Arrow keys. Move keyboard focus within the individual components of a group of components--for
example, within menu items in a menu or within tabs in a tabbed pane.

• 

The shortcuts are divided into the following categories:

Keyboard shortcuts for the Desktop and Child Wndows• 
Keyboard shortcuts for Tree Views• 
Keyboard shortcuts for Table Views• 
Keyboard shortcuts for Editing within Tree and Table Views• 
Keyboard shortcuts for the Preferences Dialog• 
Keyboard shortcuts for Text Editing Fields• 

Keyboard Shortcuts for the Desktop and Child Windows

Action Keystroke Notes

New File Ctrl-N

Open File Ctrl-O

Save File Ctrl-S

Save File As Ctrl-A

Save All Files Ctrl-L

Open Workspace Ctrl-ALT-O

Save Workspace Ctrl-ALT-S

Tile Horizontally Ctrl-H

Tile Vertically Ctrl-V

Maximise Windows Ctrl-M

Restore Windows Ctrl-R

Minimise Windows Ctrl-I

Closes Child Window Ctrl-F4

Moves Child Window Ctrl-F7

Resizes Child Window Ctrl-F8

Minimizes Child Window Ctrl-F9

Switch to next Child Window on the
Desktop

Ctrl-F6

 Keyboard Short Cuts 118



Keyboard Shortcuts for Tree Views

Action Keystroke Notes

Expands current Object Right arrow

Collapses current Object, or moves focus
to Parent Object

Left arrow

Moves focus up one Object Up arrow

Moves focus down one Object Down arrow

Moves focus to first Object in Tree View Home

Moves focus to last Object in Tree View End

Moves up one view Page Up

Moves down one view Page Down

Selects all Objects in Tree View Ctrl-A, Ctrl-/

Deselects all Objects in Tree View Ctrl-\

Extends selection down Shift-down
arrow

Extends selection up Shift-up arrow

Extends selection to beginning of Tree
View

Shift-Home

Extends selection to end of  Tree View Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Shortcuts for Table Views

Action Keystroke Notes

Moves up one row Up arrow
Shift-Return

Moves down one row Down arrow
Return 

Scrolls up one view Page Up

Scrolls down one view Page Down

Moves focus and view to first cell in the
current row

Home

Moves focus and view to last cell in the
current row

End

Moves focus and view to first cell in the
current column

Ctrl-Home

Moves focus and view to last cell in the
current column

Ctrl-End

Allows editing in a Category cell F2, Down Arrow

Allows editing in a Name cell. F2

Resets cell to the state it was in before it
was edited

Escape

Selects entire table Ctrl-A

Extends selection up one row Shift-up arrow

Extends selection down one row Shift-down
arrow

Extends selection to beginning of table Ctrl-Shift-Home

Extends selection to end of table Ctrl-Shift-End

Extends selection up one view Shift-PgUp

Extends selection down one view Shift-PgDn
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Keyboard Editing Short Cuts for both Tree and Table Views

Action Keystroke Notes

Undo Ctrl-Z

Redo Ctrl-Y

Cut Ctrl-X

Copy Ctrl-C

Paste Ctrl-V

Find Ctrl-F

Find Next F3

Find Category Ctrl-Shift-F

Find Next Category Shift-F3

Goto Ctrl-G

Insert Object INS Not allowed on
Collections

Delete Object DEL Not allowed on
Collections

Rename Object F4 Single Named Object
Only

Initialise Object F5

List References F6 Single Named Object
Only

Map To Flash F7

Map To Ram Shift-F7

Export to MIDI Edit Buffer F8 Single Voice or
Performance Only

Export to MIDI Memory Shift-F8 Voices or
Performances Only

Import from MIDI Edit Buffer F9 Single Voice or
Performance Only

Import from MIDI Memory Shift-F9 Voices or
Performances Only

MIDI Data Routing F12 Opens the MIDI Data
Router
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Keyboard Shortcuts for the Preferences Dialog

Action Keystroke Notes

Navigates through tabs Arrow keys

Moves from tab to its associated content
pane

Ctrl-down arrow

Moves from content pane to its
associated tab

Ctrl-up arrow

Keyboard Shortcuts for Text Editing Fields

Action Keystroke Notes

Moves insertion point one character to
the right

Right arrow

Moves insertion point one character to
the left

Left arrow

Moves insertion point to beginning of
next word

Ctrl-right arrow

Moves insertion point to beginning of
previous word

Ctrl-left arrow

Moves insertion point to beginning of
field

Home

Moves insertion point to end of field End

Submits text entry Enter, Return

Extends selection to beginning of line Shift-Home

Extends selection to end of line Shift-End

Extends selection one character to the
left

Shift-left arrow

Extends selection one character to the
right

Shift-right arrow

Extends selection to next word Shift-Ctrl-right
arrow

Extends selection to previous word Shift-Ctrl-left
arrow
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Credits
Jim Atfield for general debugging duties, including OSX compatibility, and for also checking out the
behaviour of the installer on MAC OSX, and then for loaning me his iMac so that I could sort out some
more pervasive issues. I now have my own Mac so I don't have to keep borrowing Jim's, or hassling
him for OSX duties anymore, but OSX support all started with Jim's help.

• 

3rd party software used in motif.factory
The following 3rd part software is used to build motif.factory and provide some program features.

CoreMIDI4J License

motif.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL 1.0
License.

Table Filter License

motif.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Apache Derby License

motif.factory makes use of Apache Derby to provide the library function, which is issued under the Apache 2.0
License.

Apache Log4J License

motif.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache 2.0
License.

Dom4J License

motif.factory makes use of Dom4J to provide XML services, which is issued under the Maplesoft Dom4J
License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Java Wizard License

The motif.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the Open Source Initiative Common Development and Distribution License.

I have adapted the Wizard software to allow me to display two progress bars in the Wizard. If anybody wishes
to have the source code for how I did this, please email me at supportx@xfactory-librarians.co.uk and I will
happily provide the adapted source code.
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motif.factory License
The unregistered version of motif.factory allows you to evaluate the features of the program, which are fully
functional except the File Save, MIDI Export and Librarian features.

However, motif.factory cannot be included as part of a commercial distribution or on other web sites without
the express permission of the Author. I am happy for you to provide links to www.xfactory-librarians.co.uk, to
maximise public access to motif.factory.

motif.factory license files are issued to users who have registered motif.factory, to gain access to the File
Save, MIDI Export and Librarian features. If you have been issued with a license key you are not allowed to
distribute a license key to other users. Please respect this, and the amount effort I have put into making this
application.

You are permitted to install and activate motif.factory on two computers, for which the license is valid.

If you wish to install and activate motif.factory on more than two computers, then an additional license can be
purchased at 50% of the cost of the main license.

The Author retains the copyright on the program and all of its originally developed features.

Disclaimer
Like all software products, this software is provided "AS IS", and without any warranties expressed or implied.
But hey, remember, you're getting it for a very low cost!

I have worked hard to ensure this software works correctly, as I certainly don't want it trashing my data.
However, I cannot be held liable for any problems arising as a consequence of you using this software on
your computer and your data. You use this product at your risk.

Like all new products, please proceed and evaluate with care, and ensure that all your important data files are
backed up before installation and evaluation.

Having gotten that out of the way, if you do encounter any problems, please submit a bug report
to support@xfactory-librarians.co.uk, and I will endeavour to provide a fix for any reported problems.

Licensing Conditions for 3rd party software
Apache Derby License

motif.factory makes use of Apache Derby to provide the library function, which is issued under the Apache 2.0
License.

Apache Log4J License

motif.factory makes use of Apache Log4J to provide logging services, which is issued under the Apache 2.0
License.

CoreMIDI4J License

motif.factory makes use of CoreMIDI4J to provide MIDI support on OS X, which is issued under the EPL 1.0
License.

Dom4J License

motif.factory makes use of Dom4J to provide XML services, which is issued under the Maplesoft Dom4J
License.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Java Wizard License

The motif.factory Library Batch Importer makes use of the Java Wizard Project which is distributed under
the Open Source Initiative Common Development and Distribution License.

Table Filter License

motif.factory makes use of TableFilter by Luis M. Pena, which is issued under the MIT License.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Tritonus License

motif.factory makes use of Tritonus Java Sound Extensions, which is issued under the GNU Lesser General
Public License.
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https://wizard.dev.java.net/
http://www.opensource.org/licenses/cddl1.php
http://www.byteslooser.com/tablefilter/index.html
mailto:byteslooser@gmail.com
http://www.opensource.org/licenses/mit-license.php
http://tritonus.org/
http://www.gnu.org/licenses/lgpl-3.0.html
http://www.gnu.org/licenses/lgpl-3.0.html
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